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Vorwort







Dieses Buch wurde von Michael Margolis, zusammen mit Nick Weldin, geschrieben, um Sie die erstaunlichen Dinge entdecken zu lassen, die man mit Arduino machen kann.

Arduino ist eine Familie von Mikrocontrollern (kleinen Computern) und eine Umgebung zur Software-Entwicklung, die es Ihnen leicht macht, Programme (sog. Sketches) zu entwickeln, die mit der physikalischen Welt interagieren. Mit Arduino entwickelte Dinge können auf Berührungen, Töne, Wärme und Licht reagieren. Diese Technik, auch physical computing genannt, wird in den unterschiedlichsten Dingen, vom iPhone bis zur Automobilelektronik verwendet. Arduino ermöglicht es jedermann – auch Menschen ohne Programmier- oder Elektronikkenntnisse –, diese mächtige und komplexe Technik zu nutzen.

Leserkreis







Im Gegensatz zu den meisten technischen Kochbüchern wird keinerlei Erfahrung mit Soft- und Hardware vorausgesetzt. Dieses Buch richtet sich an Leser, die Computertechnik nutzen wollen, um mit ihrer Umgebung zu interagieren. Es ist für Leute gedacht, die eine schnelle Lösung für ihre Hard- und Softwareprobleme suchen. Die Rezepte bieten die Informationen, die Sie benötigen, um eine große Bandbreite von Aufgaben zu erledigen. Sie enthalten auch Details, die Ihnen dabei helfen, Lösungen an Ihre Bedürfnisse anzupassen. Ein auf 600 Seiten beschränktes Buch kann nicht den allgemeinen theoretischen Hintergrund vermitteln. Daher finden Sie überall im Buch Links auf externe Referenzen. Im Abschnitt »Was ausgelassen wurde«Section  finden sich einige allgemeine Referenzen für diejenigen ohne Programmier- und Elektronikkenntnisse.

Wenn Sie keine Programmiererfahrung haben – vielleicht haben Sie eine gute Idee für ein interaktives Projekt, verfügen aber nicht über das notwendige Wissen, um es bauen zu können –, hilft Ihnen dieses Buch, das zu lernen, was Sie zum Schreiben funktionierender Programme brauchen. Dazu verwenden wir Beispiele, die über 200 gängige Aufgaben behandeln.

Wenn Sie über Programmiererfahrung verfügen, aber nicht mit Arduino vertraut sind, sorgt das Buch für ein schnelleres produktives Arbeiten, indem es demonstriert, wie man Arduino-spezifische Fähigkeiten in ein Projekt integriert.

Wenn Sie bereits mit Arduino vertraut sind, werden Sie den Inhalt nützlich finden, der Ihnen neue Techniken anhand praktischer Beispiele vermittelt. Das hilft Ihnen bei komplexeren Projekten, indem es zeigt, wie man Probleme mit Hilfe Ihnen möglicherweise noch nicht bekannter Techniken löst.

Erfahrene C/C++-Programmierer finden Beispiele für den Einsatz der auf niedriger Ebene angesiedelten AVR-Ressourcen (Interrupts, Timer, I2C, Ethernet etc.), die bei der Entwicklung von Anwendungen mit der Arduino-Umgebung helfen.



Organisation







Das Buch enthält Informationen, die ein breites Spektrum der Arduino-Fähigkeiten abdecken. Sie reichen von grundlegenden Konzepten und gängigen Aufgaben bis hin zu fortgeschrittenen Techniken. Jede Technik wird in einem Rezept erläutert, das zeigt, wie man eine bestimmte Fähigkeit implementiert. Sie müssen den Inhalt nicht der Reihe nach lesen. Nutzt ein Rezept eine Technik, die in einem anderen Rezept behandelt wird, finden Sie eine Referenz auf das andere Rezept, d.h., die Details werden nicht an mehreren Stellen wiederholt.

Chapter 1, Erste Schritte führt in die Arduino-Umgebung ein und erläutert die Arduino-Installation.

Die nächsten Kapitel führen in die Arduino-Software-Entwicklung ein. Chapter 2, Den Sketch machen lassen, was Sie wollen, behandelt grundlegende Softwarekonzepte und Aufgaben. Chapter 3, Mathematische Operatoren nutzen zeigt, wie man die gängigsten mathematischen Funktionen verwendet.

Chapter 4, Serielle Kommunikation beschreibt, wie man den Arduino mit Ihrem Computer und anderen Geräten verbindet und mit ihnen kommuniziert. Seriell ist die für Arduino gängigste Methode der Ein- und Ausgabe, die im gesamten Buch von vielen Rezepten genutzt wird.

Chapter 5, Einfacher digitaler und analoger Input führt eine Reihe grundlegender Techniken zum Lesen digitaler und analoger Signale ein. Darauf aufbauend zeigt Chapter 6, Werte von Sensoren einlesen, wie man Bauelemente nutzt, die es Arduino ermöglichen, Berührungen, Töne, Positionen, Wärme und Licht wahrzunehmen.

Chapter 7, Visuelle Ausgabe behandelt die Steuerung von Licht. Die Rezepte zeigen, wie man ein oder mehrere LEDs einschaltet und Helligkeit und Farbe kontrolliert. Dieses Kapitel erläutert, wie man Strichskalen und numerische LED-Displays ansteuert und wie man Muster und Animationen mit LED-Arrays erzeugt. Für Einsteiger enthält das Kapitel zusätzlich eine allgemeine Einführung in die digitale und analoge Ausgabe.

Chapter 8, Physische Ausgabe erklärt, wie man mit dem Arduino Dinge mittels Motoren bewegen kann. Es werden unterschiedlichste Motortypen behandelt: Spulen, Servomotoren, Gleichstrom- und Schrittmotoren.

Chapter 9, Audio-Ausgabe zeigt, wie man mit de Arduino Töne über ein Ausgabegerät wie einen Lautsprecher erzeugt. Es behandelt einfache Töne und Melodien und das Abspeichern von WAV-Dateien und MIDI.

Chapter 10, Externe Geräte fernsteuern beschreibt Techniken, mit denen Sie mit nahezu jedem Gerät interagieren können, das irgendeine Form von Fernbedienung nutzt: Fernseher, Audiogeräte, Kameras, Garagentore, Haushaltsgeräte und Spielzeug. Es baut auf den Techniken zur Verbindung des Arduino mit anderen Bauelementen und Modulen auf.

Chapter 11, Displays nutzen behandelt die Verbindung mit Text- und LC-Displays. Es zeigt, wie man diese Geräte anbindet, um Text auszugeben, Wörter scrollt und hervorhebt und spezielle Symbole und Zeichen erzeugt.

Chapter 12, Datum und Uhrzeit behandelt die in Arduino fest integrierten zeitbezogenen Funktionen und stellt zusätzliche Techniken für Zeitverzögerungen, zur Zeitmessung und reale Zeit- und Datumsangaben vor.

Chapter 13, Kommunikation per I2C und SPI behandelt die I2C-(Inter-Integrated Circuit-) und SPI-(Serial Peripheral Interface-)Standards. Diese Standards bieten eine einfache Möglichkeit, Informationen digital zwischen Sensoren und dem Arduino zu übertragen. Das Kapitel zeigt, wie man I2C und SPI nutzt, um gängige Bauelemente anzubinden. Es zeigt auch, wie man zwei oder mehr Arduino-Boards für Multiboard-Anwendungen über I2C miteinander verbindet.

Chapter 14, Drahtlose Kommunikation behandelt die drahtlose Kommunikation mittels XBee und anderen Wireless-Modulen. Die Beispiele reichen vom einfachen Drahtlos-Ersatz für serielle Ports bis hin zu Mesh-Netzwerken, die mehrere Boards mit mehreren Sensoren verbinden.

Chapter 15, Ethernet und Netzwerke beschreibt die vielen Möglichkeiten, wie Sie Arduino fürs Internet benutzen können. Es enthält Beispiele, die zeigen, wie man Web-Clients und -Server erstellt und nutzt und erläutert die gebräuchlichen Internet-Protokolle.

Arduino Softwarebibliotheken sind der übliche Ansatz, um die Arduino-Umgebung um zusätzliche Funktionen zu erweitern. Chapter 16, Bibliotheken nutzen, ändern und aufbauen erläutert, wie man Softwarebibliotheken nutzt und modifiziert. Es enthält auch eine Anleitung zur Entwicklung eigener Bibliotheken.

Chapter 16, Bibliotheken nutzen, ändern und aufbauen behandelt die fortgeschrittenen Programmiertechniken, und die Inhalte sind etwas technischer als die Rezepte in den vorherigen Kapiteln, weil sie Dinge abdecken, die ansonsten von freundlichen Arduino-Kumpels erledigt werden.

Die Rezepte aus diesem Kapitel können dazu eingesetzt werden, um einen Sketch effizienter zu schreiben, sie können Ihnen dabei helfen, die Performance zu verbessern und den Code schlanker zu schreiben.

Die Anhänge sowie Kapitel 17 und 18 wurden nicht übersetzt. Sie stehen in Englisch als Download auf unserer Webseite zur Verfügung.

Anhang A enthält eine Übersicht der im Buch verwendeten Komponenten.

Anhang B erklärt, wie man Schaltpläne und Datenblätter verwendet.

Anhang C bietet eine kurze Einführung in die Verwendung von Steckbrettern, den Anschluss und Einsatz externer Stromversorgungen und Batterien sowie der Nutzung von Kondensatoren zur Entstörung.

Anhang D enthält Tipps zur Behebung von Compiler- und Laufzeitproblemen.

Anhang E behandelt Probleme mit elektronischen Schaltungen.

Anhang F enthält Tabellen mit den Funktionen der einzelnen Pins bei Standard-Arduino-Boards.

Anhang G enthält Tabellen mit den ASCII-Zeichen.

Anhang H erklärt, wie man Code für ältere Releases anpasst, damit er unter Arduino 1.0 korrekt läuft.



Was ausgelassen wurde







Das Buch bietet nicht genug Platz, um Elektronik in Theorie und Praxis zu erläutern, auch wenn Anleitungen für den Bau der in den Rezepten verwendeten Schaltungen gegeben werden. Für genauere Informationen sei der Leser auf das im Internet zahlreich vorhandene Material oder auf die folgenden Bücher verwiesen:

	Make: Elektronik (ISBN 978-3-89721-601-3) von Charles Platt


	Arduino für Einsteiger (ISBN 978-3-86899-232-8) von Massimo Banzi


	Die elektronische Welt mit Arduino entdecken (ISBN 978-3-89721-319-7) von Erik Bartmann


	Making Things Talk (ISBN 978-3-86899-162-8) von Tom Igoe






Dieses Kochbuch erklärt, wie man Code schreibt, der bestimmte Arbeiten erledigt, es ist jedoch keine Einführung in die Programmierung. Wichtige Programmierkonzepte werden kurz erklärt, doch der Platz reicht nicht aus, um auf die Details einzugehen. Wenn Sie mehr über die Programmierung lernen wollen, sei auf das Internet verwiesen.

Nicht in die deutsche Übersetzung aufgenommen wurden die Kurzkapitel »Advanced Coding and Memory Handling«, »Using the Controller Chip Hardware« sowie die Anhänge, um einen akzeptablen Verkaufspreis für das Buch zu gewährleisten.

Diese Kapitel sind als Originalkapitel in PDF-Form von unserer Webseite www.oreilly.de downloadbar.



Code-Stil (Über den Code)







Für das gesamte Buch wurde der Code maßgeschneidert, um das Thema des jeweiligen Rezepts ganz deutlich zu machen. Infolgedessen wurden gängige Kürzel vermieden, insbesondere in den frühen Kapiteln. Erfahrene C-Programmierer verwenden häufig mächtige, aber sehr knappe Ausdrücke, die für Anfänger etwas schwer verständlich sind. Zum Beispiel werden in den frühen Kapiteln Variablen mit expliziten Ausdrücken inkrementiert, die für Nichtprogrammierer leicht verständlich sind:

    result = result + 1; // Zähler inkrementieren

und nicht in der von erfahrenen Programmierern üblicherweise genutzten Kurzform, die das Gleiche macht:

   result++;  // Inkrement mittels Postinkrement-Operator

Es steht Ihnen natürlich frei, den von Ihnen bevorzugte Stil zu verwenden. Anfängern sei versichert, dass die Kurzform keinerlei Vorteil bei Performance oder Codegröße bringt.

Einige Programmierausdrücke sind so gängig, dass wir ihre Kurzform verwenden. Zum Beispiel werden Schleifen immer wie folgt geschrieben:

for(int i=0; i < 4; i++)

was mit folgendem identisch ist:

int i;
for(i=0; i < 4; i = i+1)

Weitere Details zu diesen und anderen im Buch verwendeten Ausdrücken finden Sie in Chapter 2.

Gute Programmierpraxis verlangt, dass die verwendeten Werte gültig sind, d.h., dass man sie prüft, bevor man sie in Berechnungen nutzt. Damit sich der Code aber auf das eigentliche Rezept konzentriert, haben wir nur sehr wenige Fehlerprüfungen eingefügt.



Arduino-Version







Diese Ausgabe wurde für Arduino 1.0 aktualisiert. Der gesamte Code wurde mit dem neuesten Arduino 1.0 Release Candidate getestet, der zur Drucklegung verfügbar war (RC2). Der Download-Code für diese Ausgabe wird bei Bedarf online aktualisiert, um die finale Release 1.0 zu unterstützen. Besuchen Sie also die Buch-Website, um den neuesten Code zu erhalten. Der Download enthält eine Datei namens changelog.txt, die den Code beschreibt, der sich von der gedruckten Version unterscheidet.

Obwohl viele Sketches mit früheren Arduino-Releases laufen, müssen Sie die Endung von .ino in .pde ändern, um den Sketch in eine Pre-1.0-IDE zu laden. Wenn Sie nicht auf Arduino 1.0 migriert sind und gute Gründe haben, bei einer älteren Release zu bleiben, können Sie den Beispielcode der ersten Ausgabe nutzen (verfügbar unter http://shop.oreilly.com/product/9780596802486.do), der mit den Releases 0018 bis 0022 getestet wurde. Beachten Sie, dass viele Rezepte der zweiten Ausgabe erweitert wurden, weshalb wir ein Upgrade auf Arduino 1.0 empfehlen. Hilfe zur Migration älteren Codes finden Sie in Anhang H (steht als Download bereit).

Dort finden Sie auch einen Link zum Fehlerverzeichnis. Das Fehlerverzeichnis gibt Ihnen die Möglichkeit, uns über (Druck-)Fehler und andere Probleme mit dem Buch zu informieren. Fehler sind auf der Seite sofort sichtbar und werden von uns bestätigt, sobald wir sie überprüft haben. O’Reilly kann die Fehler in zukünftigen Auflagen und auf Safari korrigieren.

Wenn Sie Probleme haben, Beispiele ans Laufen zu bekommen, überprüfen Sie in der Datei changelog.txt des aktuellsten Downloads, ob der Sketch aktualisiert wurde. Falls das Ihr Problem nicht löst, sehen Sie sich Anhang D (steht als Download bereit) an, das die Behebung von Softwareproblemen behandelt. Falls Sie mehr Hilfe benötigen, ist das Arduino-Forum ein guter Ort, um Fragen zu stellen: http://www.arduino.cc.

Wenn Sie dieses Buch mögen – oder auch nicht –, sollten es die Leute unbedingt erfahren. Amazon-Rezensionen sind eine beliebte Möglichkeit, Ihre Zufriedenheit und andere Kommentare mit anderen zu teilen. Sie können auch auf der O’Reilly-Site zu diesem Buch einen Kommentar hinterlassen.



Verwendete Konventionen







In diesem Buch werden die folgenden typographischen Konventionen verwendet:

	Kursivschrift

	wird für Pfad-, Datei- und Programmnamen, Internetadressen, Domainnamen und URLs verwendet, sowie für neue Begriffe, wenn sie zum ersten Mal im Text auftauchen.


	Nichtproportionalschrift

	wird für Kommandozeilen und Optionen verwendet, die Sie wortwörtlich eingeben müssen. Ebenso bei Namen und Schlüsselwörtern in Programmen, einschließlich Methoden-, Variablen- und Klassennamen sowie HTML-Tags.


	Nichtproportionalschrift fett

	wird für Hervorhebungen im Programmcode verwendet.


	Nichtproportionalschrift kursiv

	wird für Text verwendet, der durch Benutzereingaben ersetzt werden muss.






Note

Zeigt einen Tipp, eine Empfehlung oder einen allgemeinen Hinweis an.



Warning

Zeigt eine Warnung an.





Verwendung der Codebeispiele







Dieses Buch soll Ihnen bei der Arbeit mit Arduino helfen. Den Code, den wir hier zeigen, dürfen Sie generell in Ihren Programmen und Dokumentationen verwenden. Sie brauchen uns nicht um Genehmigung zu bitten, sofern Sie nicht große Teile des Codes reproduzieren. Wenn Sie zum Beispiel ein Programm schreiben, das mehrere Codeabschnitte aus diesem Buch verwendet, brauchen Sie unser Einverständnis nicht. Doch wenn Sie eine CD-ROM mit Codebeispielen aus O'Reilly-Büchern verkaufen wollen, müssen Sie sehr wohl eine Erlaubnis einholen. Eine Frage mit einem Zitat und einem Codebeispiel aus diesem Buch zu beantworten, erfordert keine Erlaubnis, aber es ist nicht ohne Weiteres gestattet, große Teile unseres Textes oder Codes in eine eigene Produktdokumentation aufzunehmen.

Wir freuen uns über eine Quellenangabe, verlangen sie aber nicht zwingend. Zu einer Quellenangabe gehören normalerweise der Titel, der Autor, der Verlag und die ISBN, zum Beispiel: »Arduino Kochbuch, von Michael Margolis mit Nick Weldin (O’Reilly). Copyright 2012 Michael Margolis, Nicholas Weldin, 978-86899-353-0.«

Wenn Sie das Gefühl haben, dass Ihr Einsatz unserer Codebeispiele über die Grenzen des Erlaubten hinausgeht, schreiben Sie uns bitte eine E-Mail an permissions@oreilly.com.
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Hinweise zur Neuauflage







Die Neuauflage dieses Buchs folgt recht schnell auf die erste (die Erstauflage wurde nicht ins Deutsche übersetzt). Das wurde durch die Veröffentlichung von Arduino 1.0 nötig. Das genannte Ziel von 1.0 besteht darin, signifikante Änderungen einzuführen, die den Weg für zukünftige Verbesserungen ebnen. Leider funktioniert damit einiger Code nicht nicht mehr, der für ältere Software geschrieben wurde. Das hat dazu geführt, dass Code in vielen Kapiteln des Buches geändert werden musste. Die meisten Änderungen finden sich in Chapter 15, Ethernet und Netzwerke und Chapter 13, Kommunikation per I2C und SPI, doch alle Rezepte dieser Ausgabe wurden auf 1.0 migriert und viele wurden dahingehend aktualisiert, dass sie neue Features dieser Release nutzen. Wenn Sie eine Release vor Arduino 1.0 nutzen, können Sie den Code der ersten Auflage des Buches herunterladen.

Anhang H (steht als Download bereit) wurde hinzugefügt, um die Änderungen zu beschreiben, die mit Arduino Release 1.0 eingeführt wurden. Er erläutert, wie man älteren Code an Arduino 1.0 anpasst.

Rezepte für nicht mehr weit verbreitete Bauelemente wurden für aktuelle Bauteile aktualisiert, und einige neue Sensoren und Drahtlosgeräte wurden hinzugefügt.

An die O’Reilly-Site gepostete Fehler wurden behoben. Wir danken den Lesern, die sich die Zeit genommen haben, uns darüber zu informieren.

Wir denken, dass Ihnen die Verbesserungen an Arduino 1.0 und an dieser Auflage des Arduino Kochbuchs gefallen werden. Die erste Auflage ist gut angekommen. Die konstruktive Kritik teilte sich zwischen Leuten auf, die es technischer haben wollten, und Leuten, die es sich weniger technisch wünschten. Bei einem Buch, bei dem wir auf nur ca. 600 Seiten beschränkt sind (damit es bezahl- und tragbar bleibt), scheint das für ein gutes Gleichgewicht zu sprechen.






Chapter 1. Erste Schritte







1.1. Einführung







Die
 Arduino-Umgebung wurde entworfen, um von Anfängern einfach genutzt werden zu können, die mit Software oder Elektronik keine Erfahrung haben. Mit Arduino können Sie Objekte entwickeln, die auf Licht, Töne und Bewegung reagieren oder sie kontrollieren. Arduino wurde für den Bau einer Vielzahl faszinierender Dinge verwendet, darunter Musikinstrumente, Roboter, Lichtskulpturen, Spiele, interaktive Möbel und sogar interaktive Kleidung.

Note

Wenn Sie kein Einsteiger sind, können Sie gleich mit den Rezepten weitermachen, die Sie interessieren.



Arduino wird auf der ganzen Welt in vielen Bildungsprogrammen genutzt, insbesondere von Designern und Künstlern, die auf einfache Weise Prototypen herstellen wollen, ohne allzu tief in die technischen Details ihrer Schöpfungen einsteigen zu müssen. Da sie entworfen wurde, um von nicht technisch versierten Menschen genutzt zu werden, enthält die Software viele Codebeispiele, die demonstrieren, wie man die verschiedenen Fähigkeiten der Arduino-Boards nutzt.

Obwohl sie einfach zu nutzen ist, arbeitet die Arduino zugrunde liegende Hardware mit der gleichen »Perfektion«, die Ingenieure für den Aufbau eingebetteter Systeme nutzen. Für Leute, die bereits mit Mikrocontrollern gearbeitet haben, ist Arduino aufgrund der agilen Entwicklungsmöglichkeiten und der Möglichkeit zur schnellen Implementierung von Ideen ebenfalls interessant.

Arduino ist für seine Hardware bekannt, doch man benötigt auch Software, um diese Hardware programmieren zu können. Sowohl die Hardware als auch die Software wird »Arduino« genannt. Diese Kombination ermöglicht die Entwicklung von Projekten, die die physikalische Welt wahrnehmen und steuern können. Die Software ist frei, Open Source und plattformübergreifend. Die Boards kann man kostengünstig kaufen oder selbst zusammenbauen (die Hardware-Designs sind ebenfalls Open Source). Darüber hinaus gibt es eine aktive und unterstützende Arduino-Community, die weltweit über die Arduino-Foren und das Wiki (bekannt als
 Arduino Playground) zugänglich ist. Die Foren und das Wiki bieten Beispiele für Projekte und Problemlösungen. Sie bieten Hilfe und Inspiration, wenn Sie Ihr eigenes Projekt vorantreiben wollen.

Die Rezepte in diesem Kapitel ermöglichen Ihnen den Einstieg. Sie zeigen Ihnen, wie man die Entwicklungsumgebung einrichtet und wie man einen Beispiel-Sketch kompiliert und ausführt.

Note

Der Quellcode mit den Computer-Instruktionen zur Steuerung von Arduino-Funktionen wird in der Arduino-Community üblicherweise als Sketch bezeichnet. Das Wort Sketch wird im gesamten Buch für Arduino-Programmcode verwendet.



Der mit Arduino mitgelieferte Blink-Sketch ist ein Beispiel für die Rezepte in diesem Kapitel, auch wenn das letzte Rezept des Kapitels etwas weitergeht. Es lässt nicht nur die auf dem Board vorhandene LED blinken, sondern fügt noch Sound hinzu und liest Eingaben über zusätzliche Hardware ein. Chapter 2 zeigt, wie man einen Sketch für Arduino strukturiert und führt in die Programmierung ein.

Note

Wenn Sie mit den Arduino-Grundlagen bereits vertraut sind, können Sie mit den nachfolgenden Kapiteln weitermachen. Als Arduino-Einsteiger macht sich das Durcharbeiten dieser frühen Rezepte später mit besseren Ergebnissen bezahlt.



Arduino-Software







Software-

 Programme, sog.
 Sketches, werden auf einem Computer mit Hilfe der Arduino-

 Entwicklungsumgebung (Integrated Development Environment, kurz IDE) geschrieben. Die IDE ermöglicht es Ihnen, Code zu schreiben und zu bearbeiten und diesen Code dann in Instruktionen umzuwandeln, die die Arduino-Hardware versteht. Die IDE überträgt diese Instruktionen auch auf das Arduino-Board. Diesen Prozess bezeichnet man als
 Hochladen (engl. Uploading).



Arduino-Hardware







Auf dem

 Arduino-Board wird der von Ihnen geschriebene Code ausgeführt. Das Board selbst kann nur auf Strom reagieren und ihn steuern, weshalb spezielle Komponenten angeschlossen sind, die die Interaktion mit der realen Welt ermöglichen. Diese Komponenten können Sensoren sein, die bestimmte Aspekte der physikalischen Welt in Strom umwandeln, die das Board verarbeiten kann. Es können aber auch sog. Aktuatoren sein, die Strom vom Board erhalten und ihn in etwas umwandeln, was die Welt verändert. Beispiele für Sensoren sind Schalter, Beschleunigungsmesser und Ultraschall-Abstandssensoren. Aktuatoren sind Dinge wie Lampen und LEDs, Lautsprecher, Motoren und Displays.

Es gibt eine Vielzahl offizieller Boards, die mit der Arduino-Software verwendet werden können, sowie ein breites Spektrum an Arduino-kompatiblen Boards, die von Mitgliedern der Community hergestellt werden.

Die beliebtesten Boards enthalten einen USB-Stecker, der die Stromversorgung übernimmt und die Upload-Verbindung für ihre Software herstellt. Figure 1-1 zeigt ein einfaches Board, mit dem viele Leute anfangen: das Arduino Uno.

[image: Einfaches Board: das Arduino Uno. Photo mit freundlicher Genehmigung von todo.to.it.]



Figure 1-1. Einfaches Board: das Arduino Uno. Photo mit freundlicher Genehmigung von todo.to.it.



Das
 Arduino Uno besitzt einen zweiten Mikrocontroller, der die gesamte USB-Kommunikation übernimmt. Der kleine SMD-Chip (ein ATmega8U2) ist nahe des USB-Steckers zu finden. Dieser Chip kann separat programmiert werden, so dass das Board unterschiedliche USB-Geräte emulieren kann (ein Beispiel finden Sie in ). Das
 Arduino Leonardo ersetzt die ATmega8U2- und ATmega328-Controller durch einen einzelnen ATmega32u4-Chip, der das USB-Protokoll softwaremäßig emuliert. Die Arduino-kompatiblen Teensy- und Teensy+-Boards von PJRC (http://www.pjrc.com/teensy/) können ebenfalls USB-Geräte emulieren. Ältere Boards (und die meisten Arduino-kompatiblen Boards) verwenden einen Chip von FTDI, der eine Hardware-USB-Lösung bietet, mit der man die Verbindung mit dem seriellen Port des Computers herstellen kann.

Sie können Boards kaufen, die so klein wie eine Briefmarke sind, etwa das Arduino Mini und das Pro Mini. Größere Boards (wie das Arduino Mega) bieten mehr Anschlüsse und leistungsfähigere Prozessoren. Es gibt auch Boards für spezielle Anwendungen, etwa das LilyPad, das man in Kleidung integrieren kann (»Wearable«-Anwendungen), das Fio für Wireless-Projekte, oder das Arduino Pro für Embedded-Anwendungen (eigenständige, häufig batteriebetriebene Projekte).

Jüngstes Mitglied ist das Arduino ADK, das über einen USB-Host-Sockel verfügt und mit dem Android Open Accessory Development Kit kompatibel ist (der offiziellen Methode, Hardware an Android-Geräte anzuschließen). Das Leonardo-Board verwendet einen Controller-Chip (den ATmega32u4), der unterschiedliche HID-Geräte repräsentieren kann. Das Ethernet-Board enthält eine Ethernet-Schnittstelle und eine Power-Over-Ethernet-Option, d.h., man kann das Board über ein einziges Kabel anbinden und mit Strom versorgen.

Es gibt noch weitere Arduino-kompatible Boards, einschließlich der folgenden:

	Arduino Nano, ein kleines, USB-fähiges Board von Gravitech (http://store.gravitech.us/arna30wiatn.html)


	Bare Bones Board, ein preiswertes Board mit oder ohne USB von Modern Device (http://www.moderndevice.com/products/bbb-kit)


	Boarduino, ein preiswertes, für Steckbretter geeignetes Board von Adafruit Industries
 (http://www.adafruit.com/)


	Seeeduino, eine flexible Variante des Standard-USB-Boards von Seeed Studio Bazaar
 (http://www.seeedstudio.com/)


	Teensy und Teensy++, kleine, aber extrem vielseitige Boards von PJRC
 (http://www.pjrc.com/teensy/)






Eine Liste Arduino-kompatibler Boards finden Sie unter http://www.freeduino.org/.



Siehe auch







Übersicht der Arduino-Boards
: http://www.arduino.cc/en/Main/Hardware.

Online-Leitfäden für den Arduino-Einstieg finden Sie unter http://arduino.cc/en/Guide/Windows für Windows, http://arduino.cc/en/Guide/MacOSX für Mac OS X und http://www.arduino.cc/playground/Learning/Linux für Linux.

Eine Liste von über einhundert Boards, die mit der Arduino-Entwicklungsumgebung genutzt werden können, finden Sie unter http://jmsarduino.blogspot.com/2009/03/comprehensive-arduino-compatible.html





1.2. Installation der integrierten Entwicklungsumgebung (IDE)







Problem







Sie möchten die

 Arduino-Entwicklungsumgebung auf Ihrem Computer installieren.



Lösung







Die Arduino-Software
 für Windows, Mac und Linux kann von http://arduino.cc/en/Main/Software heruntergeladen werden.

Der Windows-Download ist eine ZIP-Datei. Entpacken Sie die Datei in ein geeignetes Verzeichnis – Programme/Arduino ist eine gute Wahl.

Note

Ein freies Utility zum Entpacken von Dateien namens 7-Zip kann von http://www.7-zip.org/ heruntergeladen werden.



Das Entpacken der Datei erzeugt einen Ordner namens Arduino-00<nn> (dabei ist <nn> die Versionsnummer der heruntergeladenen Arduino-Release). Das Verzeichnis enthält neben verschiedenen Dateien und Ordnern auch eine ausführbare Datei namens Arduino.exe. Klicken Sie Arduino.exe doppelt an und der »Splash Screen« (siehe Figure 1-2) sollte erscheinen, gefolgt vom Haupt-Programmfenster (siehe Figure 1-3). Haben Sie Geduld: Es kann einige Zeit dauern, bis die Software geladen ist.

[image: Arduino Splash Screen (Version 1.0 unter Windows 7)]



Figure 1-2. Arduino Splash Screen (Version 1.0 unter Windows 7)





[image: IDE-Hauptfenster (Arduino 1.0 auf einem Mac)]



Figure 1-3. IDE-Hauptfenster (Arduino 1.0 auf einem Mac)



Der Arduino-Download für den
 Mac ist ein Disk-Image (.dmg). Klicken Sie die Datei doppelt an, nachdem der Download abgeschlossen ist. Das Image wird gemountet (und erscheint wie ein Speicherstick auf dem Desktop). Innerhalb des Disk-Images befindet sich die Arduino-Anwendung. Kopieren Sie sie an einen geeigneten Ort – der Ordner Programme ist eine gute Wahl. Sobald Sie die Datei kopiert haben, klicken Sie sie doppelt an (sie aus dem Disk-Image auszuführen, ist keine gute Idee). Der Splash Screen erscheint, gefolgt vom Haupt-Programmfenster.

Die Linux-

 Installation ist von der verwendeten Linux-Distribution abhängig. Informationen finden Sie im Arduino-Wiki (http://www.arduino.cc/playground/Learning/Linux).

Damit die Arduino-Entwicklungsumgebung mit dem Board kommunizieren kann, müssen Sie Treiber installieren.

Unter Windows,

 verbinden Sie Ihren PC und das Arduino-Board über ein USB-Kabel und warten, dass der
 »Neue Hardware«-Assistent erscheint. Wenn Sie ein
 Uno-Board verwenden, lassen Sie den Assistenten versuchen, die Treiber zu suchen und installieren. Der Versuch schlägt fehl (keine Sorge, das ist das erwartete Verhalten). Um das zu beheben, wechseln Sie nun nach Startmenü→Systemsteuerung→System und Sicherheit. Klicken Sie auf System und öffnen Sie den Gerätemanager. In der dargestellten Liste wählen Sie dann den Eintrag in COM und LPT namens Arduino UNO (COM nn). nn ist die Nummer, die Windows dem für das Board erzeugten Port zugewiesen hat. Daneben sehen Sie eine Warnung, da die richtigen Treiber noch nicht zugewiesen wurden. Klicken Sie den Eintrag mit der rechten Maustaste an und wählen Sie Treibersoftware aktualisieren. Wählen Sie dann die Option »Browse my computer for driver software« und bewegen Sie sich in den Drivers-Ordner im eben entpackten Arduino-Ordner. Wählen Sie die Datei ArduinoUNO.inf, und Windows sollte den Installationsprozess abschließen.

Wenn Sie ein älteres Board (das
 FTDI-Treiber verwendet) mit Windows Vista oder Windows 7 nutzen und online sind, können Sie den Assistenten nach Treibern suchen lassen, und sie sollten automatisch installiert werden. Unter Windows XP (oder wenn Sie keinen Internetzugang haben) müssen Sie die Lage des Treibers angeben. Bewegen Sie sich in der Dateiauswahl ins Verzeichnis FTDI USB Drivers. Sie finden es in dem Verzeichnis, in dem Sie die Arduino-Dateien entpackt haben. Sobald der Treiber installiert ist, erscheint wieder der »Neue Hardware«-Assistent mit der Meldung, eine neue serielle Schnittstelle sei gefunden worden. Folgen Sie nun den Anweisungen von vorhin.

Note

Es ist wichtig, dass Sie diese Schritte zur Installation des Treibers zweimal durchgehen, da die Software anderenfalls nicht mit dem Board kommunizieren kann.



Auf dem Mac sollten neuere Arduino-Boards
 wie das Uno ohne zusätzliche Treiber genutzt werden können. Wenn Sie das Board zum ersten Mal anschließen, erscheint ein Hinweis, dass eine neue Netzwerkschnittstelle gefunden wurde. Bei älteren Boards (die FTDI-Treiber benötigen), müssen Sie Treibersoftware installieren. Im Disk-Image finden Sie ein Paket namens
 FTDIUSBSerialDriver mit einer Reihe von Zahlen dahinter. Klicken Sie das Paket an und der Installer führt Sie durch den Prozess. Sie müssen das Administrationspasswort kennen, um den Vorgang abschließen zu können.

Unter Linux ist der Treiber bei den meisten Distributionen bereits installiert. Informationen zu Ihrer Distribution finden Sie unter dem Linux-Link, der in der Kapiteleinführung genannt wurde.



Diskussion







Falls die Software nicht startet, besuchen Sie den Fehlersuche-Bereich der Arduino-Website unter http://arduino.cc/en/Guide/Troubleshooting. Hier finden Sie Hinweise zur Lösung von Installationsproblemen.



Siehe auch







Online-Leitfäden für den Arduino-Einstieg finden Sie unter http://arduino.cc/en/Guide/Windows für Windows, http://arduino.cc/en/Guide/MacOSX für Mac OS X und http://www.arduino.cc/playground/Learning/Linux für Linux.





1.3. Das Arduino-Board einrichten







Problem







Sie möchten ein Arduino-Board

 einschalten und sicherstellen, dass es funktioniert.



Lösung







Verbinden Sie das Board mit einem USB-Port Ihres Computers und stellen Sie sicher, dass die grüne Betriebs-LED leuchtet. Standard Arduino-Boards (Uno, Duemilanove und Mega) haben eine grüne Betriebs-LED in der Nähe des Reset-Tasters.

Eine orange LED nahe der Mitte der Platine (»Pin 13 LED« in Figure 1-4) sollte an- und ausgehen, sobald das Board eingeschaltet ist. Boards werden werksseitig mit vorinstallierter Software ausgeliefert, die die LED ein- und ausschaltet. Auf diese Weise lässt sich einfach prüfen, ob das Board
 funktioniert.

[image: Einfache Arduino-Board (Duemilanove und Uno)]



Figure 1-4. Einfache Arduino-Board (Duemilanove und Uno)





Bei neuen Boards wie dem
 Leonardo befinden sich die
 LEDs in der Nähe des USB-Anschlusses (siehe Figure 1-5). Neue Boards haben auch doppelte Pins für  I2C (SCL und SDA). Diese Boards besitzen auch einen Pin namens
 IOREF, mit dessen Hilfe die Betriebsspannung des



 Chips bestimmt werden kann.

[image: Leonardo-Board]



Figure 1-5. Leonardo-Board



Note

Der neue Standard der aktuellen Boards verfügt über drei zusätzliche Anschlüsse im Anschlusslayout. Das hat keinen Einfluss auf ältere Shields, die in den neuen Boards genauso laufen wie in den alten. Die neuen Anschlüsse bestehen aus dem Pin IOREF, mit dem die analoge Referenzspannung ermittelt werden kann (so dass die analogen Eingangswerte mit der Stromversorgung abgeglichen werden können), sowie aus den Pins SCL and SDA, die eine konsistenteVerbindung für I2C-Geräte ermöglichen. Die Lage der I2C-Pins ist bei älteren Boards eine andere, da die Chips unterschiedlich konfiguriert sind. Für das neue Layout entwickelte Shields sollten mit jedem Board laufen, das die neue Lage der Pins nutzt. Ein weiterer Pin (neben dem IOREF-Pin) wird momentan nicht genutzt, ermöglicht aber die zukünftige Implementierung neuer Features, ohne das Pin-Layout erneut ändern zu müssen.





Diskussion







Leuchtet die Betriebs-LED nicht, wenn das Board mit dem Computer verbunden ist, erhält das Board wahrscheinlich keinen Strom.

Die blinkende LED (die mit dem digitalen Ausgang an Pin 13 verbunden ist) wird durch Code gesteuert, der auf dem Board läuft (bei neuen Boards ist der Blink-Sketch vorinstalliert). Wenn die LED an Pin 13 blinkt, wird der Sketch korrekt ausgeführt, was wiederum bedeutet, dass der Chip auf dem Board funktioniert. Wenn die grüne Betriebs-LED leuchtet, die LED an Pin 13 aber nicht blinkt, kann es sein, dass der Code werksseitig nicht auf dem Chip installiert wurde. Folgen Sie den Anweisungen in Recipe 1.4, um den Blink-Sketch auf das Board zu laden und die Funktionstüchtigkeit des Boards zu überprüfen. Wenn Sie kein Standard-Board verwenden, gibt es möglicherweise keine feste LED an Pin 13. Dann müssen Sie die Details des Boards in der Dokumentation nachlesen. Beim Leonardo-Board sieht es so aus, als würde die LED »atmen«, wenn das Board funktioniert.



Siehe auch







Online-Leitfäden für den Arduino-Einstieg finden Sie unter http://arduino.cc/en/Guide/Windows für Windows, http://arduino.cc/en/Guide/MacOSX für Mac OS X und http://www.arduino.cc/playground/Learning/Linux für Linux.

Hilfe bei der Fehlersuche finden Sie unter http://arduino.cc/en/Guide/Troubleshooting.





1.4. Einen Arduino-Sketch mit der integrierten Entwicklungsumgebung (IDE) bearbeiten







Problem







Sie wollen einen Sketch
 bearbeiten und für den Upload auf das Board vorbereiten.



Lösung







Verwenden Sie die Arduino-IDE, um Sketches anzulegen, zu öffnen und zu ändern. (Sketches legen fest, was das Board machen soll.) Sie können diese Aktionen über die Buttons am oberen Rand durchführen (siehe Figure 1-6) oder die Menüs und Tastaturkürzel (siehe Figure 1-7) nutzen.

Im Sketcheditor
 betrachten und editieren Sie den Code eines Sketches. Er unterstützt gängige Textbearbeitungs-Tasten wie Ctrl-F (⌘+F auf dem Mac) für die Suche, Ctrl-Z (⌘+Z auf dem Mac) für Undo, Ctrl-C (⌘+C auf dem Mac) für das Kopieren markierten Textes und Ctrl-V (⌘+V auf dem Mac) für das Einfügen von Text.

Figure 1-7 zeigt, wie man den Blink-Sketch lädt
 (der Sketch ist auf neuen Arduino-Boards vorinstalliert).

Nachdem Sie die IDE gestartet haben, wechseln Sie in das Menü File → Examples und wählen 1. Basics→Blink (siehe Figure 1-7). Der Code, der die eingebaute LED blinken lässt, erscheint im Sketch-Editor (siehe Figure 1-6).

Bevor der Code auf das Board übertragen werden kann, muss er in Instruktionen umgewandelt werden, die vom Arduino-Controller-Chip gelesen und ausgeführt werden können. Diesen Vorgang bezeichnet man als
 Kompilierung. Dazu klicken Sie den Compiler-Button (den oben links mit dem Häkchen) an, oder wählen Sketch→Verify/Compile (Ctrl-R; ⌘+R auf dem Mac).

Im Nachrichtenbereich unter dem Editor sollte die Meldung »Compiling sketch...« und eine Fortschrittsanzeige erscheinen. Nach ein oder zwei Sekunden erscheint die Meldung »Done Compiling«. Der schwarze Konsolenbereich enthält zusätzlich die folgende Meldung:

Binary sketch size: 1026 bytes (of a 32256 byte maximum)

Die genaue Meldung hängt von Ihrem Board und der Arduino-Version ab. Sie gibt an, wie groß der Sketch ist und welche Größe Ihr Board maximal akzeptiert.

[image: Arduino-IDE]



Figure 1-6. Arduino-IDE





Diskussion







Der Quellcode für Arduino wird
 Sketch genannt. Der Prozess, der einen solchen Sketch in eine Form umwandelt, die auf dem Board funktioniert, nennt man
 Kompilierung. Die IDE nutzt hinter den Kulissen eine Reihe von Kommandozeilen-Werkzeugen, um einen Sketch zu kompilieren. Weitere Informationen hierzu finden Sie im Rezept 17.1.

[image: IDE-Menü (Auswahl des Blink-Beispiel-Sketches)]



Figure 1-7. IDE-Menü (Auswahl des Blink-Beispiel-Sketches)



Die abschließende Meldung, die die Größe des Sketches angibt, sagt Ihnen, wie viel Programmspeicher benötigt wird, um die Controller-Instruktionen auf dem Board zu speichern. Ist der
 kompilierte Sketch größer als der auf dem Board verfügbare Speicher, erscheint die folgende Fehlermeldung:

Sketch too big; see http://www.arduino.cc/en/Guide/Troubleshooting#size
 for tips on reducing it.

In diesem Fall müssen Sie den Sketch
 kürzen, damit er auf das Board passt, oder Sie müssen sich ein Board mit einer höheren Kapazität besorgen.

Wenn der Code selbst fehlerhaft ist, gibt der Compiler ein oder mehrere
 Fehlermeldungen im Konsolenfenster aus. Diese Meldungen helfen bei der Identifikation des Fehlers. Tipps zur Behebung von Softwarefehlern finden Sie im Anhang D (steht als Download bereit).

Note

Um das versehentliche Überschreiben der Beispiele zu verhindern, erlaubt es die Arduino-IDE nicht, Änderungen an den Beispiel-Sketches zu speichern. Sie müssen sie zuerst mit der Menüoption Save As umbenennen. Selbst geschriebene Sketches können mit dem Save-Button gespeichert werden (siehe Recipe 1.6).



Während Sie einen Sketch
 entwickeln und verändern, sollten Sie die Menüoption File → Save regelmäßig nutzen und verschiedene Namen oder Versionsnummern verwenden, so dass Sie bei der Implementierung bei Bedarf auf eine ältere Version zurückgreifen können.

Note

Auf das Board hochgeladener Code kann nicht wieder auf den Computer heruntergeladen werden. Stellen Sie also sicher, dass Ihr Sketch-Code auf dem Computer gespeichert ist. Sie können Änderungen an den Beispieldateien auch nicht speichern, sondern müssen Save As nutzen und der geänderten Datei einen anderen Namen geben.





Siehe auch







Recipe 1.6 zeigt einen Beispiel-Sketch. Anhang D (steht als Download bereit) gibt Hinweise zur Fehlersuche bei Software-Problemen.





1.5. Den Blink-Sketch hochladen und ausführen







Problem







Sie wollen Ihren kompilierten Sketch an das


 Arduino-Board senden und ausführen.



Lösung







Verbinden Sie Ihr Arduino-Board über ein USB-Kabel mit Ihrem Computer. Laden Sie den Blink-Sketch wie in

 Recipe 1.4 beschrieben in die IDE.

Als nächstes wählen Sie Tools→Board aus dem Dropdown-Menü und wählen den Namen des angeschlossenen Boards (falls Sie ein Standard-Uno-Board verwenden, ist es wahrscheinlich der erste Eintrag in der Board-Liste).

Nun wählen Sie Tools→Serial Port. Es erscheint eine Dropdown-Liste der auf Ihrem Computer verfügbaren seriellen Ports. Jeder Rechner hat eine andere Kombination serieller Ports, je nachdem welche anderen Geräte auf dem Computer verwendet werden.

Unter Windows wird eine Liste durchnummerierter COM-Einträge ausgegeben. Gibt es nur einen Eintrag, dann wählen Sie ihn aus. Bei mehreren Einträgen ist Ihr Board wahrscheinlich der letzte Eintrag.

Bei einem Mac wird Ihr Board zweimal aufgeführt, wenn es sich um ein Uno-Board handelt:

/dev/tty.usbmodem-XXXXXXX
/dev/cu.usbmodem-XXXXXXX

Ein älteres Board wird wie folgt aufgeführt:

/dev/tty.usbserial-XXXXXXX
/dev/cu.usbserial-XXXXXXX

Jedes Board besitzt einen anderen Wert für XXXXXXX. Wählen Sie einen beliebigen Eintrag.

Klicken Sie den Upload-Button an (in Figure 1-6 der zweite Button von links), oder wählen Sie File→Upload to I/O board (Ctrl-U, ⌘+U auf einem Mac).

Die Software kompiliert den Code wie in Recipe 1.4 beschrieben. Nachdem die Software kompiliert wurde, wird sie auf das Board hochgeladen. Wenn Sie auf das Board schauen, sehen Sie, dass die LED aufhört zu blinken und zwei LEDs (die »Seriell«-LEDs in Figure 1-4) direkt unter der eben noch blinkenden LED für einige Sekunden flackern, während der Code hochgeladen wird. Die ursprüngliche LED fängt dann wieder an zu blinken, sobald der Code ausgeführt wird.



Diskussion







Damit die IDE kompilierten Code an das Board senden kann, muss das Board mit dem Computer verbunden sein und Sie müssen der IDE mitteilen, welches Board und welchen seriellen Port Sie verwenden.

Wenn ein Upload beginnt, wird ein auf dem Board laufender Sketch angehalten (wenn der Blick-Sketch läuft, hört die LED auf zu blinken). Der neue Sketch wird auf das Board hochgeladen und ersetzt den vorhandenen Sketch. Der neue Sketch wird ausgeführt, sobald das Hochladen erfolgreich abgeschlossen wurde.

Note

Ältere Arduino-Boards (und einige kompatible) unterbrechen einen laufenden Sketch zur Initiierung des Uploads nicht. In diesem Fall müssen Sie die Reset-Taste auf dem Board drücken, sobald die Kompilierung abgeschlossen ist (d.h., wenn Sie die Meldung zur Größe des Sketches sehen). Möglicherweise brauchen Sie einige Versuche, bis Sie das richtige Timing zwischen dem Ende der Kompilierung und dem Drücken des Reset-Tasters hinbekommen.



Die IDE gibt eine

 Fehlermeldung aus, wenn der Upload nicht erfolgreich war. Die typischen Probleme sind falsch gewählte Boards oder serielle Ports, oder nicht korrekt angeschlossene Boards. Das gewählte Board und der serielle Port werden in der Statusleiste am unteren Rand des Arduino-Fensters angezeigt.

Wenn Sie Schwierigkeiten haben, den richtigen Port unter Windows zu bestimmen, trennen Sie das Board vom Computer, wählen Tools→Serial Port und sehen nach, welcher COM-Port nicht mehr in der Liste steht. Ein anderer Ansatz besteht darin, die Ports nacheinander auszuwählen, bis die LEDs des Boards zu flackern beginnen (was bedeutet, dass der Code hochgeladen wird).



Siehe auch







Die Arduino-Seite
 zur Fehlersuche: http://www.arduino.cc/en/Guide/Troubleshooting.





1.6. Einen Sketch erstellen und speichern







Problem







Sie möchten einen



 Sketch erstellen und auf dem Computer speichern.



Lösung







Um ein Editor-Fenster zu öffnen, in das Sie einen neuen Sketch eingeben können, starten Sie die IDE (siehe Recipe 1.4), wechseln ins File-Menü und wählen New. Geben Sie den folgenden Code im Sketch-Editor ein
 (es ähnelt dem Blink-Sketch, aber die Blinkdauer ist doppelt so lang):

const int ledPin =  13;    // Mit Pin 13 verbundene LED

void setup()
{
  pinMode(ledPin, OUTPUT);
}

void loop()
{
  digitalWrite(ledPin, HIGH);   // LED einschalten
  delay(2000);                  // Zwei Sekunden warten
  digitalWrite(ledPin, LOW);    // LED ausschalten
  delay(2000);                  // Zwei Sekunden warten
}

Kompilieren Sie den Code durch Anklicken des Compiler-Buttons (oben links mit dem Häkchen), oder wählen Sie Sketch→Verify/Compile (siehe Recipe 1.4).

Laden Sie den Code über den Upload-Button oder über File→Upload to I/O board (siehe Recipe 1.5) hoch. Nach dem Hochladen sollte die LED in einem Intervall von zwei Sekunden blinken.

Sie können den Sketch auf dem Computer sichern, indem Sie den Save-Button anklicken oder File→Save auswählen.

Sie können den Sketch unter einem neuen Namen sichern, indem Sie die Menüoption Save As wählen. Es erscheint eine Dialogbox, in die Sie den neuen Dateinamen eintragen können.



Diskussion







Wenn Sie eine Datei mit der IDE sichern, erscheint eine Standard-Dialogbox des Betriebssystems. Per Voreinstellung wird der Sketch in einem Ordner namens Arduino unter Eigene Dateien (bzw. dem Dokumenten-Ordner auf einem Mac) gespeichert. Sie können den voreingestellten Sketch-Namen durch einen sinnvollen Namen ersetzen, der den Zweck des Sketches widerspiegelt.

Note

Der Standardname besteht aus dem Wort Sketch, gefolgt vom aktuellen Datum. Bei a beginnende Zeichenfolgen werden verwendet, um am gleichen Tag angelegte Sketches zu unterscheiden. Den Standardnamen durch etwas Sinnvolles zu ersetzen, hilft Ihnen dabei, den Zweck des Sketches zu erkennen, wenn Sie ihn später wieder bearbeiten.



Wenn Sie von der IDE nicht erlaubte Zeichen verwenden (z.B. ein Leerzeichen), ersetzt die IDE sie automatisch durch gültige Zeichen.

Arduino-Sketches werden als reine Textdateien mit der
 Erweiterung .ino gespeichert. Ältere Versionen der IDE verwenden die Erweiterung .pde, die auch von Processing genutzt wird. Sie werden automatisch in einem Ordner gesichert, der den gleichen Namen hat wie der Sketch.

Sie können Ihre Sketches in jedem beliebigen Ordner Ihres Computers sichern, doch wenn Sie den Standardordner nutzen (den Arduino-Ordner unterhalb Ihrer Dokumente), erscheinen die Sketches automatisch im Sketchbook-Menü der Arduino-Software und sind leichter zu finden.

Note

Wenn Sie eines der Beispiele des Arduino-Downloads bearbeitet haben, können Sie die Änderungen nicht unter dem gleichen Dateinamen sichern. Auf diese Weise bleiben die Standard-Beispiele unangetastet. Wenn Sie das modifizierte Beispiel sichern wollen, müssen Sie einen anderen Ort für den Sketch wählen.



Wenn Sie Änderungen vorgenommen haben und einen Sketch schließen, erscheint eine Dialogbox, die Sie fragt, ob Sie die Änderungen sichern wollen.

Note

Das Symbol § hinter dem Namen des Sketches in der oberen Leiste des IDE-Fensters zeigt an, dass der Sketch-Code geändert, aber noch nicht auf dem Computer gesichert wurde. Das Symbol wird entfernt, wenn der Sketch gesichert wird.



Die Arduino-Software

 bietet keinerlei Versionskontrolle. Wenn Sie also zu einer älteren Version Ihres Sketches zurückkehren wollen, müssen Sie Save As regelmäßig verwenden und jeder Version des Sketches einen etwas anderen Namen geben.

Die häufige Kompilierung während der Bearbeitung ist eine gute Möglichkeit, den von Ihnen geschriebenen Code auf Fehler zu überprüfen. Fehler aufzuspüren und zu korrigieren, wird auf diese Weise einfacher, weil sie direkt mit Ihren aktuellen Eingaben zusammenhängen.

Note

Sobald ein Sketch auf ein Board hochgeladen wurde, gibt es keine Möglichkeit, ihn wieder auf den Rechner herunterzuladen. Sichern Sie also alle Änderungen an Ihren Sketches, die Sie behalten wollen.



Wenn Sie versuchen, einen Sketch zu sichern, der nicht in einem Ordner liegt, der den gleichen Namen wie der Sketch hat, informiert Sie die IDE darüber, dass das so nicht geht, und empfiehlt, OK anzuklicken, um einen Ordner mit dem gleichen Namen für den Sketch
 anzulegen.

Note

Sketches müssen in einem Ordner liegen, der den gleichen Namen hat wie der Sketch. Die IDE legt den Ordner automatisch an, wenn Sie einen neuen Sketch sichern.

Mit älterer Arduino-Software entwickelte Sketches verwenden eine andere Dateierweiterng (.pde). Die IDE öffnet sie und erzeugt eine Datei mit einer neuen Erweiterung (.ino), wenn Sie sie sichern. Für ältere Versionen der IDE enwickelter Code kompiliert unter der Version 1.0 möglicherweise nicht. Die meisten Änderungen, die notwendig sind, um älteren Code ans Laufen zu kriegen, sind aber einfach vorzunehmen. Details finden Sie in Anhang H (steht als Download bereit).





Siehe auch







Der Code in diesem Rezept (und im Rest des Buches) verwendet den Ausdruck const int, um für Konstanten sinnvolle Namen (ledPin) anstelle von Zahlen (13) zu nutzen. Mehr zur Verwendung von Konstanten finden Sie in Rezept 17.5 (steht als Download bereit).





1.7. Arduino verwenden







Problem







Sie möchten ein Projekt

 beginnen, das einfach zu bauen ist und gleichzeitig Spaß macht.



Lösung







Dieses Rezept bietet einen Vorgeschmack auf einige der Techniken, die in späteren Kapiteln detailliert behandelt werden.

Der Sketch basiert auf dem

 Code für die blinkende LED aus dem vorherigen Rezept. Anstelle eines festen Zeitintervalls wird die Dauer aber über einen Sensor, einen lichtempfindlichen Widerstand, bestimmt
 (siehe Recipe 6.3). Verdrahten Sie den lichtempfindlichen Widerstand wie in Figure 1-8 gezeigt.

[image: Arduino mit lichtempfindlichem Widerstand]



Figure 1-8. Arduino mit lichtempfindlichem Widerstand





Note

Wenn Sie nicht damit vertraut sind, einen Schaltkreis nach einem Schaltplan aufzubauen, sehen Sie sich Anhang B (steht als Download bereit) an. Hier wird Schritt für Schitt gezeigt, wie man eine Schaltung auf einem Steckbrett aufbaut.



Der folgende Sketch liest die Lichtintensität des lichtempfindlichen Widerstands ein, der mit dem analogen Pin 0 verbunden ist. Diese Lichtintensität verändert die Blinkgeschwindigkeit der internen LED an Pin 13:

const int ledPin =  13;     // Mit Pin 13 verbundene LED
const int sensorPin = 0;    // Mit Analogeingang 0 verbundener Sensor

void setup()
{
  pinMode(ledPin, OUTPUT);  // LED-Pin als Ausgang aktivieren
}

void loop()
{
  int rate = analogRead(sensorPin);    // Analogen Eingang einlesen
  digitalWrite(ledPin, HIGH);   // LED einschalten
  delay(rate);                  // Wartezeit abhängig von Lichtintensität
  digitalWrite(ledPin, LOW);    // LED ausschalten
  delay(rate);
}



Diskussion







Der Wert des 4,7K-Widerstands ist unkritisch. Sie können alles zwischen 1K und 10K verwenden. Die Lichtintensität am lichtempfindlichen Widerstand ändert die Spannung an Analogpin 0. Der Befehl analogRead
 (siehe Chapter 6) liefert einen Wert zwischen 200 (dunkel) und 800 (hell) zurück. Dieser Wert bestimmt, wie lange die LED an und aus bleibt. Das Blinkintervall wird also mit zunehmender Lichtstärke länger.

Sie können das Blinkintervall mit Hilfe der Arduino-Funktion map
 wie folgt skalieren:

const int ledPin =  13;     // Mit Pin 13 verbundene LED
const int sensorPin = 0;    // Mit Analogeingang 0 verbundener Sensor

// die nächsten  beiden Zeilen legen das minimale und maximale Zeitintervall fest
const int minDuration = 100;  // Minimale Dauer
const int maxDuration = 1000;  // Maximale Dauer


void setup()
{
  pinMode(ledPin, OUTPUT);  // LED-Pin als Ausgang aktivieren
}

void loop()
{
  int rate = analogRead(sensorPin);    // Analogen Eingang einlesen
  // Die nächste Zeile skaliert das Blinkintervall auf die Minimal- und Maximalwerte
  rate = map(rate, 200,800,minDuration, maxDuration); // In Blinkintervall umwandeln
  rate = constrain(rate, minDuration,maxDuration);    // und Wert beschränken  digitalWrite(ledPin, HIGH);   // LED einschalten
  delay(rate);                  // Wartezeit abhängig von Lichtintensität
  digitalWrite(ledPin, LOW);    // LED ausschalten
  delay(rate);
}

In Recipe 5.8 wird detailliert beschrieben, wie man die map-Funktion zur Skalierung von Werten nutzt. Recipe 3.6 zeigt im Detail, wie man die
 constrain-Funktion verwendet, damit ein Wert einen bestimmten Wertebereich nicht über- oder unterschreitet.

Wenn Sie sich den Wert der rate-Variablen auf Ihrem Computer ansehen wollen, können Sie ihn über den seriellen Monitor
 ausgeben. Wie das geht, zeigt der nachfolgende, überarbeitete Code in der loop()-Funktion. Der Sketch gibt die Blinkrate über den seriellen Monitor aus. Sie öffnen den seriellen Monitor in der Arduino IDE, indem Sie das Icon rechts in der oberen Leiste anklicken (mehr zur Verwendung des seriellen Monitors finden Sie in Chapter 4):

const int ledPin =  13;     // Mit Pin 13 verbundene LED
const int sensorPin = 0;    // Mit Analogeingang 0 verbundener Sensor

// die nächsten  beiden Zeilen legen das minimale und maximale Zeitintervall fest
const int minDuration = 100;  // Minimale Dauer
const int maxDuration = 1000;  // Maximale Dauer


void setup()
{
  pinMode(ledPin, OUTPUT);  // LED-Pin als Ausgang aktivieren
  Serial.begin(9600);       // Seriellen Port initialisieren
}

void loop()
{
  int rate = analogRead(sensorPin);    // Analogen Eingang einlesen
  // Die nächste Zeile skaliert das Blinkintervall auf die Minimal- und Maximalwerte
  rate = map(rate, 200,800,minDuration, maxDuration); // In Blinkintervall umwandeln
  rate = constrain(rate, minDuration,maxDuration);    // und Wert beschränken       
  
  Serial.println(rate);         // Intervall über seriellen Monitor ausgeben
  digitalWrite(ledPin, HIGH);   // LED einschalten
  delay(rate);                  // Wartezeit abhängig von Lichtintensität
  digitalWrite(ledPin, LOW);    // LED ausschalten
  delay(rate);
}

Sie können mit dem lichtempfindlichen Widerstand auch die Tonlage eines Lautspechers steuern, wenn Sie ihn wie in Figure 1-9 anschließen.

[image: Verbinden eines Lautsprechers mit dem lichtempfindlichen Widerstand]



Figure 1-9. Verbinden eines Lautsprechers mit dem lichtempfindlichen Widerstand





Sie müssen das Ein/Aus-Intervall des Pins auf eine Frequenz im Audiospektrum erhöhen. Das wird im nachfolgenden Code erreicht, indem die minimale und maximale Dauer reduziert wird:

const int outputPin = 9;    // Mit digitalem Pin 9 verbundener Lautsprecher
const int sensorPin = 0;    // Mit Analogeingang 0 verbundener Sensor

const int minDuration = 1;   // 1ms an, 1ms aus (500 Hz)
const int maxDuration = 10;  // 10ms an, 10ms aus (50 hz)

void setup()
{
  pinMode(outputPin, OUTPUT);  // LED-Pin als Ausgang aktivieren
}

void loop()
{
  int sensorReading = analogRead(sensorPin);    // Analogeingang einlesen
  int rate = map(sensorReading, 200,800,minDuration, maxDuration);
  rate = constrain(rate, minDuration,maxDuration);    // Wert beschränken
  
  digitalWrite(outputPin, HIGH);   // LED einschalten
  delay(rate);                     // Wartezeit abhängig von Lichtintensität
  digitalWrite(outputPin, LOW);    // LED ausschalten
  delay(rate);
}



Siehe auch







In Recipe 3.6 finden Sie Details zur Verwendung der constrain-Funktion.

Recipe 5.8 beschreibt die map-Funktion.

Wenn Sie Töne erzeugen wollen, finden Sie in Chapter 9 eine umfassende Diskussion zur Audioausgabe mit dem Arduino.








Chapter 2. Den Sketch machen lassen, was Sie wollen







2.1. Einführung







Auch wenn es bei einem Arduino-Projekte zu einem großen Teil darum geht, das Arduino-Board mit der passenden Hardware zu verbinden, müssen Sie dem Board sagen können, was es denn genau damit anfangen soll. Dieses Kapitel führt in die Kernelemente der Arduino-Programmierung ein, zeigt Nicht-Programmierern, wie man gängige Sprachkonstrukte nutzt, und enhält eine Sprachübersicht für diejenigen Leser, die nicht mit C oder C++ (der von Arduino verwendeten Sprache) vertraut sind.

Damit die Beispiele interessant bleiben, müssen wir Arduino etwas machen lassen. Die Rezepte nutzen daher physikalische Fähigkeiten des Boards, die erst in späteren Kapiteln im Detail erläutert werden. Falls Ihnen der Code in diesem Kapitel nicht klar ist, sollten Sie zu den nachfolgenden Kapiteln springen, insbesondere zu Chapter 4 für die serielle Ausgabe und Chapter 5 zum Einsatz der digitalen und analogen Pins. Sie müssen aber nicht alle Codebeispiele begreifen, um zu verstehen, wie die speziellen Fähigkeiten genutzt werden, die im Fokus des jeweiligen Rezepts stehen. Hier einige gängige Funktionen, die in den nächsten paar Kapiteln behandelt werden:

	Serial.println(wert);

	Gibt den Wert über den seriellen Monitor der Arduino-IDE aus,

 so dass Sie die Arduino-Ausgabe am Computer verfolgen können; siehe Recipe 4.2.


	pinMode(pin, modus);

	Konfiguriert
 einen digitalen Pin als Eingang (lesen) oder Ausgang (schreiben). Siehe hierzu die Einführung ??? zu Chapter 5.


	digitalRead(pin);

	Liest einen

 digitalen Wert (HIGH oder LOW) über einen als Eingang festgelegten Pin ein; siehe Recipe 5.2.


	digitalWrite(pin, wert);

	Schreibt einen
 digitalen Wert (HIGH oder LOW) an einen als Ausgang festgelegten Pin; siehe Recipe 5.2.








2.2. Strukturierung eines Arduino-Programms







Problem







Sie sind Programmiereinsteiger

 und wollen die Bausteine eines Arduino-Programms verstehen.



Lösung







Programme für den Arduino werden üblicherweise als Sketches bezeichnet. Die ersten Nutzer waren Künstler und Designer, und der Begriff Sketch (Skizze/Entwurf) hebt die schnelle und einfache Möglichkeit hervor, Ideen realisieren zu können. Die Begriffe Sketch und Programm sind austauschbar. Sketches enthalten Code, also die Instruktionen, die das Board ausführen soll. Nur einmal auszuführender Code (etwa die Initialisierung des Boards für die Anwendung), muss in der setup-Funktion stehen. Code, der kontinuierlich ausgeführt werden soll, nachdem das Setup abgeschlossen wurde, kommt in die loop-Funktion. Hier ein typischer Sketch:

const int ledPin =  13;    // Mit Pin 13 verbundene LED

 // Die setup()-Methode wird beim Start des Sketches einmal ausgeführt
 void setup()
 {
   pinMode(ledPin, OUTPUT);      // Digitalen Pin als Ausgang festlegen
 }

 // Die loop()-Methode wird immer und immer wieder ausgeführt
 void loop()
 {
   digitalWrite(ledPin, HIGH);   // LED einschalten
   delay(1000);                  // Eine Sekunde warten
   digitalWrite(ledPin, LOW);    // LED ausschalten
   delay(1000);                  // Eine Sekunde warten
 }

Sobald die Arduino-IDE den Code hochgeladen hat (und bei jedem Einschalten des Boards), beginnt es am Anfang des Sketches und geht die Instruktionen nacheinander durch. Es führt den Code in setup einmal aus und geht dann den Code in loop (engl. Schleife) durch. Am Ende von loop (den die schließende geschweifte Klammer } markiert), wird zum Anfang von loop zurückgesprungen.



Diskussion







Dieses Beispiel lässt die LED fortlaufend blinken, indem es die Werte HIGH und LOW an den Pin schreibt. Mehr zur Verwendung der Arduino-Pins finden Sie in Chapter 5. Beim Start des Sketches legt der Code in setup den Modus des Pins fest (damit er die LED ein- und ausschalten kann). Nachdem der Code in setup ausgeführt wurde, wird der Code in loop, der die LED blinken lässt, in einer Endlosschleife ausgeführt, solange das Arduino-Board eingeschaltet ist.

Sie müssen Folgendes nicht wissen, um Arduino-Sketches zu schreiben, doch erfahrene C/C++-Programmierer werden sich fragen, wohin der Einsprungpunkt
 main() verschwunden ist. Er ist da, wird aber durch die Arduino-Build-Umgebung versteckt. Der Build-Prozess erzeugt eine Zwischendatei, die den Sketch-Code und die folgenden zusätzlichen Anweisungen enthält:

int main(void)
{
    init();

    setup();

    for (;;)
        loop();

    return 0;
}

Zuerst wird die Funktion
 init() aufgerufen, die die Arduino-Hardware initialisiert. Danach wird die
 setup()-Funktion des Sketches aufgerufen. Zum Schluss wird Ihre
 loop()-Funktion immer und immer wieder ausgeführt. Da die for-Schleife niemals endet, wird die return-Anweisung nie ausgeführt.



Siehe auch







Recipe 1.5 erklärt, wie man einen Sketch auf ein Arduino-Board hochlädt.

Kapitel 17 (steht als Download bereit) und http://www.arduino.cc/en/Hacking/BuildProcess enthalten weitere Informationen zum Build-Prozess.





2.3. Einfache primitive Typen (Variablen) nutzen







Problem







Arduino kennt


 verschiedene Variablentypen, um Werte effizient repräsentieren zu können. Sie wollen wissen, wie man diese Arduino-Datentypen wählt und nutzt.



Lösung







Der Datentyp
 int (kurz für Integer, bei Arduino ein 16-Bit-Wert) ist in Arduino-Anwendungen die gängige Wahl für numerische Werte. Sie können aber Table 2-1 nutzen, um den Datentyp zu bestimmen, der für Ihre Anwendung den geeigneten Wertebereich aufweist.

Table 2-1. Arduino-Datentypen






	
Numerische Typen


	
Bytes


	
Wertebereich


	
Verwendung





	
int


	
2


	
–32768 bis 32767


	
Repräsentiert
 positive und negative ganze Zahlen.




	
unsigned int


	
2


	
0 bis 65535


	
Repräsentiert nur positive ganze Zahlen. Ansonsten wie int.




	
long


	
4


	
–2147483648 bis 2147483647


	
Repräsentiert
 sehr große positive und negative ganze Zahlen.




	
unsigned long


	
4


	
4294967295


	
Repräsentiert sehr große positive ganze Zahlen.




	
float


	
4


	
3.4028235E+38 bis –3.4028235E+38


	
Repräsentiert Fließkommazahlen. Wird für Messwerte genutzt um Werte von Messungen an reale Werte anzunähern.




	
double


	
4


	
Wie float


	
Bei
 Arduino ist double nur ein anderer Name für float.




	
boolean


	
1


	
false (0) oder true (1)


	
Repräsentiert
 boolesch Wahr/Falsch-Werte.




	
char


	
1


	
–128 bis 127


	
Repräsentiert ein
 einzelnes
 Zeichen. Kann auch einen vorzeichenbehafteten Wert zwischen –128 und 127 repräsentieren.




	
byte


	
1


	
0 bis 255


	
Wie
 char, aber für vorzeichenlose Werte.










	Weitere Typen
	Verwendung



	
String


	
Repräsentiert

 Arrays von chars (Zeichen). Wird üblicherweise für Text verwendet.




	
void


	
Wird nur bei
 Funktionsdeklarationen verwendet, die keinen Wert zurückliefern.













Diskussion







Solange man keine maximale Performance oder Speichereffizienz braucht, eignen sich als int deklarierte Variablen für numerische Werte, wenn sie den Wertebereich (in der ersten Spalte in Table 2-1) nicht überschreiten und man keine Brüche (Fließkommazahlen) braucht. Die meisten offiziellen Arduino-Codebeispiele deklarieren numerische Variablen als int. Doch manchmal müssen Sie einen Typ wählen, der die speziellen Anforderungen Ihrer Anwendung erfüllt.

Manchmal braucht man negative Zahlen und manchmal nicht, weshalb es zwei Varianten numerischer Variablen gibt: signed (mit Vorzeichen) und unsigned (ohne Vorzeichen). unsigned-Werte sind immer positiv. Variablen, denen nicht das Schlüsselwort

 unsigned vorangestellt wird, arbeiten mit Vorzeichen, d.h., sie können negative und positive Werte repräsentieren. Ein Grund für die Verwendung von unsigned-Werten ist, dass die Werte möglicherweise nicht in signed-Variablen passen (der vorzeichenlose, maximale Wert einer unsigned-Variable ist doppelt so hoch wie der einer signed-Variablen). Ein weiterer Grund, warum Programmierer unsigned-Typen verwenden, liegt darin, möglichen Lesern des Codes klar anzuzeigen, dass der Wert einer Variablen niemals negativ wird.

Boolesche Typen besitzen nur zwei mögliche Werte: wahr (true) oder falsch (false). Sie werden üblicherweise verwendet, um solche Dinge zu prüfen wie den Status eines Schalters (Wurde er gedrückt oder nicht?). An den Stellen, an denen es sinnvoll ist, können Sie auch HIGH und LOW als Äquivalent zu true und false nutzen. digitalWrite(pin, HIGH) ist für das Einschalten aussagekräftiger als digitalWrite(pin, true) oder digitalWrite(pin,1), auch wenn alle Varianten, was die Ausführung des Sketches betrifft, identisch sind. Bei im Web gepostetem Code werden Ihnen sehr wahrscheinlich alle Varianten begegnen.



Siehe auch







Details zu den Datentypen finden Sie in der Arduino-Referenz an http://www.arduino.cc/en/Reference/HomePage .





2.4. Fließkommazahlen verwenden







Problem







Fließkommazahlen

 werden für Werte mit Nachkommastellen (also Brüche) verwendet. Sie möchten solche Werte in Ihren Sketches nutzen.



Lösung







Der folgende Code zeigt, wie man Fließkomma-Variablen deklariert, illustriert mögliche Probleme beim Vergleich von Fließkomma-Werten und zeigt, wie man sie vermeiden kann. Beachten Sie bitte, dass das Komma im Amerikanischen als Punkt (.) dargestellt wird:

/*
 * Fließkomma-Beispiel
 * Der Sketch initialisiert eine Variable mit
 * dem Fließkommawert 1,1 und verringert ihn 
 * fortlaufend um 0,1, bis der Wert 0 erreicht ist.
 */


float  value = 1.1;

void setup()
{
  Serial.begin(9600);
}

void loop()
{
  value = value - 0.1;   // Reduziere value bei jedem Durchlauf um 0,1.
  if( value == 0)
     Serial.println("Der Wert ist genau 0");
  else if(almostEqual(value, 0))
  {
    Serial.print("Der Wert ");
    Serial.print(value,7); // 7 Dezimalstellen ausgeben
    Serial.println(" ist fast 0");
  }
  else
    Serial.println(value);

  delay(100);
}
      
// Gibt wahr zurück, wenn die Differenz zwischen a und b klein ist.
// Der Wert von DELTA gibt die max. Differenz an, die noch als "gleich" betrachtet wird.
boolean almostEqual(float a, float b)    
{
  const float DELTA = .00001; // Max. Differenz, die noch "gleich" ist 
  if (a == 0) return fabs(b) <= DELTA;
  if (b == 0) return fabs(a) <= DELTA;
  return fabs((a - b) / max(fabs(a), fabs(b))) <= DELTA ;
}



Diskussion







Fließkommazahlen sind nicht genau, und die zurückgelieferten Werte können kleine Rundungsfehler enthalten. Diese Fehler treten auf, weil Fließkommazahlen einen großen Wertebereich abdecken, weshalb die interne Repräsentation des Wertes nur eine Näherung sein kann. Aus diesem Grund dürfen Sie nicht auf exakte Übereinstimmung testen, sondern ob die Werte innerhalb eines Tolerlanzbereichs liegen.

Der Sketch gibt auf dem seriellen Monitor folgendes aus:

1.00
0.90
0.80
0.70
0.60
0.50
0.40
0.30
0.20
0.10
Der Wert -0.0000001 ist fast 0
-0.10
-0.20

Der serielle Monitor setzt die Ausgabe negativer Zahlen fort.

Sie würden wohl erwarten, dass der Code "Der Wert ist genau 0" ausgibt, nachdem value 0,1 enthält und dann erneut 0,1 subtrahiert wird. Doch value ist nie genau Null. Der Wert ist nah dran, aber nie nah genug, um den Test if (value == 0) zu bestehen. Das liegt daran, dass der einzige speichereffiziente Weg zur Speicherung von Fließkommazahlen (die einen riesigen Wertebereich abdecken) darin besteht, eine Näherung der Zahl zu speichern.

Die Lösung besteht (wie in diesem Rezept zu sehen) darin, zu prüfen, ob die Variable nah genug am gewünschten Wert liegt.

Die Funktion almostEqual prüft, ob die Variable value im Bereich von 0,00001 des gewünschten Zielwertes liegt und gibt wahr zurück, wenn das so ist. Der akzeptable Wertebereich wird in der Konstanten DELTA festgelegt, damit Sie ganz nach Bedarf größere oder kleinere Werte einstellen können. Die Funktion


 fabs (eine Abkürzung für Fließkomma-Absolutwert) gibt den Absolutwert einer Fließkommazahl zurück, der dann genutzt wird, um die Differenz der angegebenen Parameter zu überprüfen.

Note

Fließkommazahlen sind nur Näherungen, weil nur 32 Bit zur Verfügung stehen, um alle Werte eines riesigen Wertebereichs aufzunehmen. Acht Bit werden für den dezimalen Multiplikator (den Exponenten) verwendet, bleiben 24 Bit für das Vorzeichen und den eigentlichen Wert – gerade genug für sieben signifikate Nachkommastellen.



Warning

Zwar sind float und double bei Arduino identisch, doch bei vielen anderen Plattformen bietet double eine höhere Genauigkeit. Wenn Sie Code von anderen Plattfomen importieren, der float und double mischt, müssen Sie sicherstellen, dass die Genauigkeit für Ihre Anwendung ausreicht.





Siehe auch







Die Arduino-Referenz zu float: http://www.arduino.cc/en/Reference/Float.





2.5. Mit Gruppen von Werten arbeiten







Problem







Sie wollen eine

 Gruppe von Werten (ein sog. Array) anlegen und nutzen. Arrays können einfache Listen sein, aber auch zwei oder mehr Dimensionen aufweisen. Sie wollen wissen, wie man die Größe des Arrays bestimmt und auf die Elemente des Arrays zugreift.



Lösung







Dieser Sketch verwendet zwei Arrays. Ein Array mit Pins, an denen Schalter angeschlossen sind, und ein zweites Array mit Pins, die mit LEDs verbunden sind (siehe
 Figure 2-1):

/*
 array-Sketch
 Ein Array von Schaltern steuert ein Array von LEDs
 in Chapter 5 erfahren Sie mehr über Schalter
 Informationen zu LEDs finden Sie in Chapter 7
 */

int inputPins[] = {2,3,4,5};  // Array mit Pins für die Schalter anlegen (Eingänge)

int ledPins[] = {10,11,12,13};  // Array mit Pins für die LEDs anlegen (Ausgänge)

void setup()
{
  for(int index = 0; index < 4; index++)
  {
    pinMode(ledPins[index], OUTPUT);         // LED als Ausgang deklarieren
    pinMode(inputPins[index], INPUT);        // Schalter als Eingang deklarieren
    
    digitalWrite(inputPins[index],HIGH);     // Pullup-Widerstände aktivieren
    // (siehe Recipe 5.3)
  }
}

void loop(){
  for(int index = 0; index < 4; index++)
  {
    int val = digitalRead(inputPins[index]);  // Eingabe einlesen
    if (val == LOW)                           // Prüfen, ob Schalter auf Ein steht
    {
      digitalWrite(ledPins[index], HIGH); // LED einschalten, wenn Schalter auf Ein steht,
    }
    else
    {
      digitalWrite(ledPins[index], LOW);  // sonst LED ausschalten
    }
  }
}

[image: Verbindungen für LEDs und Schalter]



Figure 2-1. Verbindungen für LEDs und Schalter







Diskussion







Arrays
 sind Gruppen aufeinanderfolgender Variablen des gleichen Typs. Jede Variable innerhalb der Gruppe wird als Element bezeichnet. Die Anzahl der Elemente nennt man die Größe des Arrays.

Die Lösung zeigt ein typisches Einsatzgebiet von Arrays im Arduino-Code: die Speicherung einer Gruppe von Pins. Die Pins sind hier mit Schaltern und LEDs verbunden (ein Thema, dem wir uns in Chapter 5 ausführlicher widmen). Die wichtigen Teile dieses Beispiels sind die Deklaration des Arrays und der Zugriff auf die Array-Elemente.

Die folgende Codezeile deklariert (erzeugt) ein Array aus vier Integer-Elementen und initialisiert jedes Element. Das erste Element wird auf 2 gesetzt, das zweite auf 3 und so weiter:

int inputPins[] = {2,3,4,5};

Wenn Sie die Werte bei der Deklaration des Arrays nicht initialisieren (z.B. weil sie erst im laufenden Sketch verfügbar sind), müssen Sie jedes Element einzeln ändern. Sie deklarieren das Array wie folgt:

int inputPins[4];

Das deklariert ein Array mit vier Elementen und setzt den Wert jedes Elements auf Null. Die Zahl innerhalb der eckigen Klammern ([]) ist die Größe, legt also die Anzahl der Elemente fest. Dieses Array hat die Größe 4 und kann daher höchstens vier Integerwerte aufnehmen. Sie können die Größe weglassen, wenn die Array-Deklaration die Werte initialisiert (wie im ersten Beispiel). Der Compiler weiß dann, wie groß das Array werden muss, indem er die Zahl der Initialisierungen mitzählt.

Das erste Element des Arrays ist element[0]:

int firstElement = inputPins[0];  // Das erste Element

inputPins[0] = 2; // Setzt den Wert dieses Elements auf 2

Das letzte Element ist 1 kleiner als die Größe des Arrays. Im obigen Beispiel mit der Größe 4 ist Element 3 das letzte Element:

int lastElement = inputPins[3]; // Das letzte Element

Sie wundern sich vielleicht, warum bei einem Array der Größe 4 das letzte Element über array[3] angesprochen wird, doch da array[0] das erste Element ist, heißen die vier Elemente:

inputPins[0],inputPins[1],inputPins[2],inputPins[3]

Im obigen Sketch erfolgt der Zugriff auf die vier Elemente in einer for-Schleife:

for(int index = 0; index < 4; index++)
{
    //Pin durch Zugriff auf jedes Element des Pin-Arrays ermitteln
    pinMode(ledPins[index], OUTPUT);         // LED als Ausgang deklarieren
    pinMode(inputPins[index], INPUT);        // Schalter als Eingang deklarieren
}

Dieses Schleife durchläuft die Variable index von 0 bis 3. Ein typischer Fehler besteht darin, versehentlich auf ein Element zuzugreifen, das außerhalb der Größe des Arrays liegt. Solche Fehler können verschiedene Symptome aufweisen, und Sie müssen darauf achten, sie zu vermeiden. Eine Möglichkeit, solche Schleifen zu kontrollieren, besteht darin, die Größe des Arrays in einer Konstanten festzuhalten:

const int PIN_COUNT = 4;  // Konstante für Anzahl der Elemente definieren
int inputPins[PIN_COUNT] = {2,3,4,5};

  for(int index = 0; index < PIN_COUNT; index++)
    pinMode(inputPins[index], INPUT);

Warning

Der Compiler meldet keinen Fehler, wenn Sie versehentlich einen Wert außerhalb der Grenzen des Arrays lesen oder schreiben. Sie müssen daher sorgfältig darauf achten, dass Sie nur auf Elemente innerhalb der von Ihnen gesetzten Grenzen zugreifen. Die Verwendung einer Konstanten für die Größe des Arrays und im Code hilft Ihnen dabei, sich innerhalb der Array-Grenzen zu bewegen.



Ein weiteres Einsatzgebiet für Arrays ist das Vorhalten

 einzelner Textzeichen. Im Arduino-Code werden sie als

 Zeichenketten (oder Strings) bezeichnet. Eine Zeichenkette besteht aus einem oder mehreren Zeichen, die mit einem Nullzeichen (dem Wert 0) abgeschlossen



 werden.

Note

Die Null am Ende des Strings ist nicht mit dem Zeichen 0 identisch. Die Null hat den ASCII-Wert 0, während 0 den ASCII-Wert 48 hat.



Methoden zur Verwendung von Strings werden in 2.6 und 2.7 behandelt.



Siehe auch







Recipe 5.3; Recipe 7.2





2.6. Arduino-Stringfunktionen nutzen







Problem







Sie wollen




 Text bearbeiten. Sie wollen ihn kopieren, verketten oder die Anzahl der Zeichen bestimmen.



Lösung







Das vorige Kapitel hat kurz angedeutet, wie man Arrays von Zeichen nutzt, um Text zu speichern. Solche Zeichen-Arrays werden üblicherweise als Strings bezeichnet. Arduino besitzt eine String-Bibliothek, die eine Vielzahl von Funktionen zur Speicherung und Bearbeitung von Text zur Verfügung stellt.

Note

Der Ausdruck String mit einem S als Großbuchstabe bezieht sich auf die Arduino-Text-Funktion, die von der Arduino-String-Bibliothek geliefert wird. Das Wort string mit dem Kleinbuchstaben s bezieht sich eher auf Zeichengruppen als auf die Arduino-String-Funktionalität.



Dieses Rezept zeigt, wie man mit Arduino-
Strings arbeitet.

Note

Die String-Bibliothek wurde mit der Version 0019 alpha (älter als 1.0) von Arduino eingeführt. Wenn Sie eine ältere Version nutzen, können Sie die TextString-Bibliothek verwenden. Beachten Sie hierzu den Link am Ende des Rezepts.



Laden Sie den folgenden Sketch auf Ihr Board und öffnen Sie den seriellen Monitor, um sich die Ergebnisse
 anzusehen:

/*
  Basic_Strings-Sketch
 */

String text1 = "Dieser String";
String text2 = "hat mehr Text";
String text3;  // Wird im Sketch zugewiesen

void setup()
{
  Serial.begin(9600);

  Serial.print( text1);
  Serial.print(" ist ");
  Serial.print(text1.length());
  Serial.println(" Zeichen lang. ");

  Serial.print("text2 ist ");
  Serial.print(text2.length());
  Serial.println(" Zeichen lang. ");

  text1.concat(text2);
  Serial.println("text1 enthaelt nun: ");
  Serial.println(text1);
}

void loop()
{
}



Diskussion







Dieser Sketch erzeugt drei Variablen namens text1, text2 und text3 vom Typ String. Variablen vom Typ String besitzen Fähigkeiten zur Bearbeitung von Text. Die Anweisung text1.length() gibt die Länge (Anzahl der Zeichen) des Strings text1 zurück.

text1.concat(text2)kombiniert die Inhalte von Strings. In unserem Beispiel wird der Inhalt von text2 an das Ende von text1 angehangen (concat ist die Abkürzung von concatenate, zu deutsch verketten).

Der serielle Monitor gibt Folgendes aus:

Dieser String ist 13 Zeichen lang.
text2 ist 14 Zeichen lang.
text1 enhält nun:
Dieser String hat mehr Text

Eine weitere Möglichkeit zur Verkettung von Strings bietet der Additionsoperator. Hängen Sie die folgenden beiden Zeilen an das Ende des setup-Codes an:

  text3 = text1 + " und mehr";
  Serial.println(text3);

Der neue Code gibt im seriellen Monitor zusätzlich noch die folgende Zeile aus:

Dieser String hat mehr Text und mehr

Sie können die Funktionen

 indexOf und lastIndexOf nutzen, um das Vorkommen eines bestimmten Zeichens in einem String zu finden.

Note

Da die String-Klasse eine recht junge Arduino-Erweiterung ist, werden Sie viel Code sehen, der statt des String-Typs mit Zeichenketten arbeitet. Weitere Informationen zur Verwendung von Zeichenketten anstelle von Arduino-Strings finden Sie in Recipe 2.7.



Wenn Sie eine Zeile wie die folgende sehen:

char oldString[] = "Dies ist eine Zeichenkette";

dann verwendet der Code Zeichenketten im C-Stil (siehe Recipe 2.7). Sieht die Deklaration hingegen so aus:

String newString = "Dies ist ein String-Objekt";

verwendet der Code Arduino-Strings. Um eine Zeichenkette im C-Stil einem Arduino-String zuzuweisen, weisen Sie einfach den Inhalt des Arrays einem String-Objekt zu:

char oldString[] = "Diese Zeichenkette soll ein String-Objekt sein";
String newString = oldString;

Um die in der Table 2-2 aufgeführten Funktionen verwenden zu können, müssen Sie sie auf ein existierendes String-Objekt anwenden, wie im folgenden Beispiel gezeigt wird:

	int len = myString.length();





Table 2-2. Kurze Übersicht der Arduino String-Funktionen




	
charAt(n)


	Gibt das n-te

 Zeichen des Strings zurück.


	
compareTo(S2)


	Vergleicht den
 String mit dem angegebenen String S2


	
concat(S2)


	Gibt einen neuen
 String zurück, bei dem der String und S2 verkettet sind.


	
endsWith(S2)


	Gibt wahr zurück
, wenn der String mit den Zeichen in S2 endet.


	
equals(S2)


	Gibt wahr zurück, wenn der
 String genau mit S2 übereinstimmt (Groß-/Kleinschreibung wird beachtet).


	
equalsIgnoreCase(S2)


	Wie equals, ignoriert aber
 die Groß-/Kleinschreibung.


	
getBytes(buffer,len)


	Kopiert len Zeichen in den angegebenen Bytepuffer.


	
indexOf(S)


	Gibt den Index
 des angegebenen Strings (oder Zeichens) zurück bzw. –1, wenn er nicht gefunden wird.


	
lastIndexOf(S)


	Wie indexOf, beginnt aber
 mit dem Ende des Strings.


	
length()


	Gibt die
 Anzahl der Zeichen im String zurück.


	
replace(A,B)


	Ersetzt alle
 Instanzen von String (oder Zeichen) A durch B.


	
setCharAt(index,c)


	Speichert das Zeichen
 c am angegebenen Index im String.


	
startsWith(S2)


	Gibt wahr
 zurück, wenn der String mit den Zeichen in S2 beginnt.


	
substring(index)


	Gibt einen
 String mit den Zeichen beginnend bei Index bis zum Ende des Strings zurück.


	
substring(index,to)


	Wie oben, aber der Substring endet vor der Zeichenposition ’to’.


	
toCharArray(buffer,len)


	Kopiert bis
 zu len Zeichen des Strings in den angegebenen Puffer.


	
toInt()


	Gibt den
 Integerwert der im String stehenen Ziffern zurück.


	
toLowerCase()


	Gibt einen
 String zurück, bei dem alle Zeichen in Kleinbuchstaben umgewandelt wurden.


	
toUpperCase()


	Gibt einen
 String zurück, bei dem alle Zeichen in Großbuchstaben umgewandelt wurden.


	
trim()


	Gibt einen
 String zurück, bei dem alle führenden und anhängenden Whitespaces entfernt wurden.









Weitere Hinweise zur Nutzung und den Varianten dieser Funktionen finden Sie auf den Arduino-Referenzseiten.

Zwischen Arduino-Strings und C-Zeichenketten wählen







Arduinos fest eingebauter Datentyp



 String ist einfacher zu nutzen als C-Zeichenketten, was aber durch komplexen Code in der String-Bibliothek erreicht wird, die größere Anforderungen an Ihren Arduino stellt und naturgemäß problematischer ist.

Der String-Datentyp ist so flexibel, weil er die

 dynamische Speicherallozierung nutzt. Wenn Sie also einen String anlegen oder modifizieren, fordert Arduino einen neuen Speicherbereich von der C-Bibliothek an. Benötigen Sie den String nicht länger, muss Arduino den Speicher wieder freigeben. Das läuft üblicherweise sauber, doch in der Praxis gibt es viele Stellen, an denen der Speicher ein »Leck« haben kann. Fehler in der String-Bibliothek können dazu führen, dass ein Teil oder der gesamte Speicher nicht freigegeben wird. Wenn das passiert, steht dem Arduino (bis zum Neustart) mit der Zeit immer weniger Speicher zur Verfügung. Und selbst wenn es kein Speicherleck gibt, ist es schwierig, Code zu schreiben, der prüft, ob ein String aufgrund unzureichenden Speichers nicht angefordert werden konnte (die String-Funktionen imitieren die von Processing, doch im Gegensatz zu dieser Plattform verfügt Arduino nicht über eine Ausnahmebehandlung von Laufzeitfehlern. Fehler mit dynamischem Speicher lassen sich nur schwer finden, da der Sketch Tage oder Wochen problemlos laufen kann, bevor es zu einem Fehlverhalten kommt.

Wenn Sie C-Zeichenketten nutzen, haben Sie die Kontrolle über die Speichernutzung: Sie allozieren eine feste (statische) Speichermenge während der Kompilierung, so dass es nicht zu einem Speicherleck kommen kann. Ihrem Arduino-Sketch steht bei jedem Lauf die gleiche Speichermenge zur Verfügung. Und wenn Sie versuchen mehr Speicher zu allozieren, als Ihnen zur Verfügung steht, ist der Fehler leichter zu ermitteln, da es Tools gibt, die Ihnen sagen, wie viel statischen Speicher Sie alloziert haben (siehe hierzu die Referenz zu avr-objdump in , als Download).

Allerdings kann es bei C-Zeichenketten leicht zu einem anderen Problem kommen: C hindert Sie nicht daran, Speicher zu ändern, der außerhalb der Grenzen des Arrays liegt. Wenn Sie also ein Array mit myString[4] allozieren und myString[4] = 'A' zuweisen (denken Sie daran, dass myString[3] das Ende des Arrays ist), wird Sie niemand daran hindern. Doch wer weiß, auf welche Speicherstelle myString[4] verweist? Und wer weiß schon, zu welchem Problem die Zuweisung von 'A' an diese Speicherstelle führt? Sehr wahrscheinlich wird es ein Fehlverhalten des Sketches verursachen.

Bei Arduinos fest eingebauter
 String-Bibliothek laufen Sie also durch die Nutzung dynamischen Speichers Gefahr, den verfügbaren Speicher aufzufressen. Bei C-Zeichenketten müssen Sie darauf achten, die Grenzen des verwendeten Arrays nicht zu überschreiten. Nutzen Sie Arduinos fest eingebaute String-Bibliothek dann, wenn Sie die umfassende Möglichkeiten zur Textbearbeitung brauchen und Strings nicht immer wieder neu erzeugen. Werden sie in einer Schleife wiederholt erzeugt und modifiziert, allozieren Sie besser ein großes C-Zeichen-Array und entwickeln den Code sorgfältig, damit Sie die Grenzen des Arrays nicht verlassen.

Ein weiterer Fall, bei dem man C-Zeichenketten gegenüber Arduino-Strings vorzieht, sind große Sketches, die einen Großteil des verfügbaren Speichers oder Flashspeichers nutzen. Der Arduino StringToInt-Beispielcode benötigt fast 2 KB mehr Flash als das Äquivalent mit C-Zeichenketten und der atoi-Funktion zur Umwandlung in einen int-Wert. Die Arduino String-Version benötigt außerdem etwas mehr RAM, um zusätzlich zum String noch Allozierungsinformationen zu speichern.

Wenn Sie den Verdacht haben, dass die String-Bibliothek oder jede andere Bibliothek, die dynamisch Speicher alloziert, ein Speicherleck hat, können Sie jederzeit den freien Speicher ermitteln. Siehe . Prüfen Sie den freien Speicher beim Start des Sketches und überwachen Sie, ob er mit der Zeit abnimmt. Wenn Sie ein Problem mit der String-Bibliothek vermuten, suchen Sie in der Liste offener Bugs (http://code.google.com/p/arduino/issues/list) nach »String«.





Siehe auch







Die Arduino-Distribution enthält
 String-Beispielsketches (File→Examples→Strings).

Die String-Referenzseite finden Sie unter http://arduino.cc/en/Reference/StringObject.

Einführungen zur neuen String-Bibliothek finden Sie unter http://arduino.cc/en/Tutorial/HomePage. Eine Einführung in die Original-String-Bibliothek (die Sie nur benötigen, wenn Sie mit einer Arduino-Version älter als 0019 alpha arbeiten) finden Sie unter http://www.arduino.cc/en/Tutorial/TextString.





2.7. C-Zeichenketten nutzen







Problem







Sie wollen

 verstehen, wie man mit Zeichenketten arbeitet. Sie wollen wissen, wie man einen solchen String erzeugt, seine Länge bestimmt, ihn vergleicht, kopiert und anhängt. Der Sprachkern von C unterstützt die String-Fähigkeiten von Arduino nicht,
 weshalb Sie den für andere Plattformen entwickelten Code verstehen wollen, der mit primitiven Zeichenketten arbeitet.



Lösung







Arrays von

 Zeichen, werden auch Zeichenketten (oder einfach Strings) genannt. Recipe 2.5 beschreibt Arduino-Arrays im Allgemeinen. Dieses Rezept beschreibt Funktionen, die mit Zeichenketten arbeiten.

Sie deklarieren
 Strings wie folgt:

char stringA[8]; // Deklariere einen String mit bis zu 7 Zeichen plus abschließender Null
char stringB[8]  = "Arduino"; // Wie oben, init(inialisiert) den String aber gleich mit "Arduino" 
char stringC[16] = "Arduino"; // Wie oben, aber der String kann wachsen
char stringD[ ]  = "Arduino"; // Der Compiler initialisiert den String und errechnet seine Größe

Verwenden Sie strlen (eine Abkürzung für string length, also Stringlänge)

, um die Anzahl der Zeichen vor der abschließenden Null zu bestimmen:

int length = strlen(string);  // Gibt die Anzahl der Zeichen im String zurück

length ist im obigen Beispiel 0 für stringA und 7 für die anderen Strings. Die Null, die das Ende des Strings festlegt, wird von strlen nicht mitgezählt.

Verwenden Sie strcpy (string copy), um

 einen String in einen anderen zu kopieren:

strcpy(destination, source);   // Kopiert den String von der Quelle (source) an das Ziel (destination)

Verwenden Sie strncpy, um die Zahl der zu kopierenden Zeichen zu beschränken. (Nützlich, um nicht mehr Zeichen zu kopieren, als der Zielstring aufnehmen kann.) Sie können sie in Recipe 2.8 im Einsatz sehen:

// Kopiere bis zu 6 Zeichen von der Quelle (source) zum Ziel(destination)
strncpy(destination, source, 6);

Verwenden Sie strcat (string concatenate), um

 einen String an das Ende eines anderen anzuhängen:

// Quellstring an das Ende des Zielstrings anhängen
strcat(destination, source);

Note

Achten Sie beim Kopieren oder Verketten immer darauf, dass das Ziel ausreichend Platz hat. Denken Sie auch an den Platz für die abschließende Null.



Verwenden Sie strcmp (string compare), um

 zwei Strings zu vergleichen. Ein Anwendungsbeispiel finden Sie in Recipe 2.8:

if(strcmp(str "Arduino") == 0)
   // Mach etwas, wenn die Variable str den String "Arduino" enthält



Diskussion







Text wird in der Arduino-Umgebung durch ein Array von Zeichen, sog. Strings, repräsentiert. Ein String besteht aus einer Folge von Zeichen, die mit einer Null (dem Wert 0) abgeschlossen wird. Die Null wird nicht ausgegeben, wird aber benötigt, um der Software das Ende des Strings anzuzeigen.



Siehe auch







Eine der vielen Online verfügbaren C/C++-Referenzseiten, etwa http://www.cplusplus.com/reference/clibrary/cstring/ und http://www.cppreference.com/wiki/string/c/start.





2.8. Durch Komma getrennten Text in Gruppen aufteilen







Problem







Ein

 String enthält zwei oder mehr Datenelemente, die durch Kommata (oder ein anderes Trennzeichen) voneinander getrennt sind. Sie wollen den String so zerlegen, dass Sie die einzelnen Elemente nutzen können.



Lösung







Dieser Sketch gibt den Text zwischen den
 Kommata aus:

/*
 * SplitSplit-Sketch
 * Kommaseparierten String zerlegen
 */

String  text = "Peter,Paul,Mary";  // Beispiel-String
String  message = text; // Enthält noch nicht zerlegten Text
int     commaPosition;  // Position des nächsten Kommas im String

void setup()
{
  Serial.begin(9600);
  
  Serial.println(message);          // Quellstring ausgeben,
  do
  {
      commaPosition = message.indexOf(',');
      if(commaPosition != -1)
      {
          Serial.println( message.substring(0,commaPosition));
          message = message.substring(commaPosition+1, message.length());
      }
      else
      {  // nachdem das letzte Komma gefunden wurde
         if(message.length() > 0)
           Serial.println(message);  // Wenn Text auf das letzte Komma folgt,
                                     // ausgeben
      }
   }
   while(commaPosition >=0);
}

void loop()
{
}

Im seriellen Monitor wird Folgendes ausgegeben:

Peter,Paul,Mary
Peter
Paul
Mary



Diskussion







Dieser Sketch nutzt String-Funktionen, um den Text zwischen den Kommata zu extrahieren. Der Code:

commaPosition = message.indexOf(',');

legt in der Variablen commaPosition die Position des ersten Kommas im String namens message ab (der Wert ist –1, wenn kein Komma gefunden wurde). Gibt es ein Komma, wird die Funktion
 substring genutzt, um den Text vom Anfang des Strings bis zum Komma auszugeben. Der ausgegebene Text samt Komma wird dann in der folgenden Zeile aus message entfernt:

message = message.substring(commaPosition+1, message.length());

substring liefert einen String zurück, der bei commaPosition+1 (der Position gleich hinter dem Komma) beginnt und sich bis zum Ende des Strings erstreckt. Message enthält dann nur noch den Text, der auf das erste Komma folgt. Das wird so lange wiederholt, bis kein Komma mehr gefunden wird (commaPosition enthält dann –1).

Als erfahrener Programmierer können Sie auch die Low-Level-Funktionen nutzen, die Teil der Standard-C-Bibliothek sind. Der folgende Sketch bietet die gleiche Funktionalität wie oben mit
 Arduino-Strings:

/*
 * SplitSplit Sketch
 * Komma separieren, String zerlegen
 */

const int  MAX_STRING_LEN = 20; // Längsten String festlegen,
                                // den Sie verarbeiten wollen
                                
char stringList[] = "Peter,Paul,Mary"; // Beispiel-String

char stringBuffer[MAX_STRING_LEN+1]; // Statischer Puffer für Berechnung und Ausgabe

void setup()
{
  Serial.begin(9600);
}

void loop()
{
  char *str;
  char *p;
  strncpy(stringBuffer, stringList, MAX_STRING_LEN); // Quellstring kopieren
  Serial.println(stringBuffer);                      // Quellstring ausgeben
  
  for( str = strtok_r(stringBuffer, ",", &p);        // An Komma zerlegen,
       str;                                          // solange str nicht Null ist,
       str = strtok_r(NULL, ",", &p)                 // nächstes Token ermitteln
     )
  {
    Serial.println(str);
  }
    delay(5000);
}

Die Kernfunktionalität liefert eine Funktion namens
 strtok_r (der Name der strtok-Version, die der Arduino-Compiler bereitstellt). Beim ersten Aufruf von strtok_r übergeben Sie den String, den Sie in Token (einzelne Werte) zerlegen wollen. Doch strtok_r überschreibt die Zeichen in diesem String jedes Mal, wenn es ein neues Token findet, weshalb man (wie in diesem Beispiel gezeigt) am besten eine Kopie des Strings übergibt. Alle nachfolgenden Aufrufe übergeben eine NULL, um die Funktion anzuweisen, sich zum nächsten Token zu bewegen. Im obigen Beispiel wird jedes Token über den seriellen Port ausgegeben.

Wenn Ihre Token nur aus Zahlen bestehen, sehen Sie sich Recipe 4.6 an. Es zeigt, wie man numerische Werte, die durch Kommata voneinander getrennt sind, aus einem Stream serieller Zeichen extrahiert.



Siehe auch







Unter http://www.nongnu.org/avr-libc/user-manual/group__avr__string.html erfahren Sie mehr über C-Stringfunktionen wie strtok_r und strcmp.

Recipe 2.6; Online- Referenzen zu den C/C++-Funktionen strtok_r und strcmp.





2.9. Eine Zahl in einen String umwandeln







Problem







Sie müssen eine



 Zahl in einen String umwandeln, etwa um sie auf einem LCD- oder einem anderen Display auszugeben.



Lösung







Die String-Variable wandelt Zahlen automatisch in Strings um. Sie können Literale oder den Inhalt einer Variablen verwenden. So funktioniert der folgende Code:

String myNumber = 1234;

Ebenso wie dieser:

int value = 127;
String myReadout = "Der Messwert ist ";
myReadout.concat(value);

Und auch dieser:

int value = 127;
String myReadout = "Der Messwert ist ";
myReadout += value;



Diskussion







Wenn Sie eine Zahl in Text umwandeln wollen, um sie auf einem LC-Display oder über eine serielle Schnittstelle auszugeben, besteht die einfachste Lösung darin, die Konvertierungsfähigkeiten zu nutzen, die in die LCD- oder Serial-Bibliotheken integriert sind (siehe Recipe 4.3). Doch vielleicht arbeiten Sie mit einem Gerät, in das die entsprechende Unterstützung nicht integriert ist (siehe Chapter 13), oder Sie wollen die Zahl in Form eines Strings in Ihrem Sketch weiterverarbeiten.

Die Arduino-Klasse String
 wandelt numerische Werte automatisch um, wenn sie einer String-Variablen zugewiesen werden. Sie können numerische Werte verketten, indem Sie die Funktion

 concat, oder den Stringoperator + nutzen.

Note

Der Operator + wird sowohl bei Zahlen als auch bei Strings verwendet, verhält sich aber leicht unterschiedlich.



Im folgenden Code erhält number den Wert 13:

    int number = 12;
    number += 1;

Bei einem String

    String textNumber = "12";
    textNumber += 1;

enthält textNumber den Textstring "121".

Vor der Einführung der String-Klasse hat Arduino-Code üblichereise die Funktionen

 itoa oder ltoa verwendet. Die Namen stehen für »integer to ASCII« (itoa) und »long to ASCII« (ltoa). Die vorhin beschriebene String-Version ist einfacher zu nutzen, doch wenn Sie lieber mit C-Zeichenketten arbeiten (siehe Recipe 2.7), können Sie den folgenden Code verwenden.

itoa und ltoa verlangen drei Parameter: den umzuwandelnden Wert, einen Puffer, der den Ausgabestring aufnimmt und die Basis (10 für Dezimal-, 16 für Hexadezimal und 2 für Binärzahlen).

Der folgende Sketch zeigt, wie man numerische Werte
 mit ltoa konvertiert:

/*
 * NumberToString
 * Erzeugt einen String aus einer Zahl
 */

void setup()
{
  Serial.begin(9600);
}

char buffer[12];  // Datentyp long hat 11 Zeichen (inklusive
                  // Minuszeichen) und ein abschließendes Null-Zeichenvoid loop()
{
  long value = 12345;
  ltoa(value, buffer, 10);
  Serial.print( value);
  Serial.print(" hat  ");
  Serial.print(strlen(buffer));
  Serial.println(" Ziffern");
  value = 123456789;
  ltoa(value, buffer, 10);
  Serial.print( value);
  Serial.print(" hat  ");
  Serial.print(strlen(buffer));
  Serial.println(" Ziffern");
  delay(1000);
}

Der Puffer muss so groß sein, dass er die maximale Anzahl von Zeichen im String aufnehmen kann. Bei 16-Bit-Integerwerten zur Basis 10 (dezimal) sind das sieben Zeichen (fünf Ziffern, ein mögliches Minuszeichen und die abschließende 0, die immer das Ende des Strings anzeigt); 32-Bit-Integerwerte benötigen 12 Zeichen (10 Ziffern, Minuszeichen und die abschließende 0). Sie erhalten keine Warnung, wenn die Puffergröße überschritten wird, doch dieser Fehler kann zu seltsamen Symptomen führen, weil der Überlauf einen anderen Teil des Speichers überschreibt, der von Ihrem Programm genutzt werden kann. Die einfachste Möglichkeit, das zu vermeiden, besteht darin, immer einen 12-Zeichen-Puffer zu verwenden und immer mit ltoa zu arbeiten, da es mit 16-Bit- und 32-Bit-Werten umgehen kann.





2.10. Einen String in eine Zahl umwandeln







Problem







Sie wollen einen



 String in eine Zahl umwandeln. Zum Beispiel könnten Sie einen Wert als String über einen Kommunikationslink empfangen haben und müssen ihn nun in einen Integer- oder einen Fließkommawert umwandeln.



Lösung







Das kann auf unterschiedliche Weise gelöst werden. Kommt der String in Form serieller Daten an, kann er während des Empfangs umgewandelt werden. Wie man das bei der seriellen Schnittstelle macht, zeigt Recipe 4.4.

Eine weitere Möglichkeit zur Umwandlung von Textstrings in Zahlen bieten die C-Konvertierungsfunktionen


 atoi (für int-Variablen) und atol (für long-Variablen).

Das folgende Code-Fragment
 terminiert die eingehenden Ziffern, sobald ein Zeichen keine Ziffer ist (oder wenn der Puffer voll ist). Damit das funktionieren kann, müssen Sie aber die Newline-Option im seriellen Monitor aktivieren oder ein anderes terminierendes Zeichen eingeben:

/*
 * StringToNumber
 * Erzeugt eine Zahl aus einem String
 */

const int ledPin = 13; // Mit Pin 13 verbundene LED

int   blinkDelay;     // Blinkrate wird durch diese Variable bestimmt
char strValue[6];     // Muss groß genug sein, um alle Ziffern und die den
                      // String abschließende 0 aufzunehmen
int index = 0;        // Index auf das die empfangenen Ziffern speichernde Array

void setup()
{
 Serial.begin(9600); 
 pinMode(ledPin,OUTPUT); // LED-Pin als Ausgang aktivieren
}

void loop()
{
  if( Serial.available())
  {
    char ch = Serial.read();
    if(index < 5 && isDigit(ch) ){
      strValue[index++] = ch; // ASCII-Zeichen an String anhängen;
    }
    else
    {
      // Bei vollem Puffer oder erster Nicht-Ziffer
      strValue[index] = 0;        // String mit einer 0 abschließen
      blinkDelay = atoi(strValue);  // String mit atoi in einen int-Wert umwandeln
      index = 0;
    }
  }
  blink();
}  

void blink()
{
   digitalWrite(ledPin, HIGH);
   delay(blinkDelay/2);  // Hälfte der Blinkperiode warten 
   digitalWrite(ledPin, LOW);
   delay(blinkDelay/2);  // Die andere Hälfe warten 
}



Diskussion







Die etwas seltsam benannten Funktionen atoi (für ASCII nach int) und atol (für ASCII nach long) wandeln einen String in Integer- oder Long-Integer-Werte um. Um Sie verwenden zu können, müssen Sie den gesamten String zuerst in einem Zeichen-Array ablegen, bevor Sie die Konvertierungsfunktion aufrufen können. Der Code erzeugt ein Zeichen-Array namens strValue, das bis zu fünf Ziffern aufnehmen kann (die Deklaration mit char strValue[6] berücksichtigt noch die abschließende Null). Er füllt das Array über
 Serial.read, bis das erste Zeichen empfangen wird, das keine Ziffer ist. Das Array wird mit einer Null abgeschlossen und dann wird die atoi-Funktion aufgerufen, um das Zeichen-Array umzuwandeln. Das Ergebnis der Umwandlung wird in blinkRate gespeichert.

Eine Funktion namens blink wird
 aufgerufen, die den in blinkDelay gespeicherten Wert nutzt.

Wie in der Warnung in Recipe 2.5 erwähnt, müssen Sie darauf achten, innerhalb der Grenzen des Arrays zu bleiben. Falls Sie nicht wissen, wie Sie das anstellen sollen, sehen Sie sich die Diskussion dieses Rezepts an.

Die Arduino-Release 22 hat die Methode toInt eingeführt, die einen String in einen Integerwert umwandelt:

 String aNumber = "1234";
 int value = aNumber.toInt();

Arduino 1.0 verfügt über die Methode parseInt,
 mit deren Hilfe Sie Integerwerte über serielle Ports oder Ethernet (oder jedem aus der Stream-Klasse abgeleiteten Objekt) einlesen können. Das folgende Code-Fragment wandelt Ziffernfolgen in Zahlen um. Es ähnelt unserer Lösung, benötigt aber keinen Puffer (und ist nicht auf Zahlen mit fünf Ziffern beschränkt):

int   blinkDelay;     // Blinkrate wird durch diese Variable bestimmt
void loop()
{
  if( Serial.available())
  {
    blinkRate = Serial.parseInt();     
  }
  blink();
  }

Note

Stream-Parsing-Methoden wie parseInt nutzen ein Timeout, um die Kontrolle wieder an den Sketch zurückzugeben, falls innerhalb der gewünschten Zeitspanne keine Daten eintreffen. Das Standard-Timeout beträgt eine Sekunde, kann aber über die Methode setTimeout geändert werden:

 Serial.setTimeout(1000 * 60); // Warte bis zu einer Minute

parseInt (und alle anderen Stream-Methoden) geben den Wert zurück, der bis zum Timeout eingelesen werden konnte (wenn kein Trennzeichen empfangen wurde). Der Rückgabewert besteht aus dem eingesammelten Wert. Wurden keine Ziffern empfangen, wird Null zurückgegeben. Arduino 1.0 hat keine Möglichkeit zu erkennen, ob es in der Parse-Methode zu einem Timeout kam, aber die Möglichkeit ist für eine zukünftige Release geplant.





Siehe auch







Dokumentation
 zu atoi finden Sie unter: http://www.nongnu.org/avr-libc/user-manual/group__avr__stdlib.html.

Viele Online-C/C++-Referenzseiten behandeln diese Low-Level-Funktionen, z.B. http://www.cplusplus.com/reference/clibrary/cstdlib/atoi/ und http://www.cppreference.com/wiki/string/c/atoi.

In Recipe 4.4 und Recipe 4.6 erfahren Sie mehr über den Einsatz von parseInt mit Serial.





2.11. Ihren Code in Funktionsblöcken strukturieren







Problem







Sie möchten wissen,


 wie man einen Sketch um Funktionen erweitert und welche Funktionalität in eine Funktion gehört. Sie wollen außerdem verstehen, wie man die Gesamtstruktur des Sketches plant.



Lösung







Funktionen werden genutzt, um die von Ihrem Sketch durchgeführten Aktionen in funktionale Blöcke zu packen. Funktionen fassen Funktionalität zu wohldefinierten Eingaben (an eine Funktion übergebene Informationen) und Ausgaben (von der Funktion gelieferte Informationen) zusammen. Das erleichtert die Strukturierung, Pflege und Wiederverwendung Ihres Codes. Sie kennen bereits zwei Funktionen, die Teil jedes Arduino-Sketches sind: setup und loop. Sie legen eine
 Funktion an, indem Sie ihren Rückgabetyp  (also die von ihr bereitgestellte Information) deklarieren, sowie ihren Namen und optionale Parameter (Werte), die die Funktion beim Aufruf verarbeitet.

Note

Die Begriffe Funktion und Methode werden für wohldefinierte Code-Blöcke verwendet, die von anderen Teilen eines Programms als einzelne Entität aufgerufen werden können. Die Sprache C bezeichnet sie als Funktionen. Objektorientierte Sprachen wie C++, die Funktionalitäten über Klassen bereitstellen, neigen eher zum Begriff Methode. Arduino verwendet einen Stilmix (die Beispiel-Sketches verwenden eher einen C-Stil, während Bibliotheken eher so geschrieben werden, dass Sie C++-Methoden zur Verfügung stellen). In diesem Buch verwenden wir üblicherweise den Begriff Funktion, solange der Code nicht durch eine Klasse bereitgestellt wird. Doch keine Sorge, wenn Ihnen die Unterscheidung nicht klar ist, können Sie beide Begriffe gleichsetzen.



Hier eine einfache Funktion, die nur eine LED blinken lässt. Es gibt keine Parameter und sie gibt auch nichts zurück (was durch das vor der Funktion stehende void festgelegt wird):

// LED einmal blinken lassen
void blink1()
{
   digitalWrite(13,HIGH);   // LED einschalten
   delay(500);              // 500 Millisekunden warten
   digitalWrite(13,LOW);    // LED ausschalten
   delay(500);              // 500 Millisekunden warten
}

Die folgende Version verwendet einen Parameter (ein Integer namens count), der bestimmt, wie oft die LED blinken soll:

// LED count mal blinken lassen
void blink2(int count)
{
  while(count > 0 )  // Solange Zähler größer 0
  {
    digitalWrite(13,HIGH);
    delay(500);
    digitalWrite(13,LOW);
    delay(500);
    count = count -1; // Zähler dekrementieren
  }
}

Note

Erfahrene Programmierer werden bemerken, dass beide Funktionen blink heißen können, da der Compiler sie anhand der als Parameter verwendeten Werte unterscheiden kann. Dieses Verhalten wird als Überladen von Funktionen bezeichnet. Das Arduino-print, das in Recipe 4.3 diskutiert wird, ist hierfür ein typisches Beispiel. Ein anderes Beispiel für das Überladen finden Sie in der Diskussion von Recipe 4.7.



Diese Version
 überprüft, ob der Wert von count 0 ist. Ist das nicht der Fall, lässt sie die LED einmal blinken und reduziert den Wert von count um 1. Das wird solange wiederholt, bis count nicht mehr größer als

 0 ist.

Note

Ein Parameter wird manchmal auch als Argument bezeichnet. Aus praktischen Erwägungen betrachten wir beide Begriffe als gleichwertig.



Hier ein Beispiel-Sketch mit einer Funktion, die einen Parameter erwartet und einen Wert zurückgibt. Der Parameter legt fest, wie lange die LED an- und ausgeschaltet bleibt (in Millisekunden). Die Funktion lässt die LED blinken, bis eine Taste gedrückt wird und gibt zurück, wie oft die LED geblinkt
 hat:

/*
  blink3 Sketch
  Demonstriert den Aufruf einer Funktion mit einem Parameter und die Rückgabe eines Wertes.
  Verwendet die gleiche Verschaltung wie im Sketch aus 
  Recipe 5.3 Die LED blinkt, sobald das Programm startet und hört auf zu blinken, sobald der mit dem digitalen Pin 2 verbundene Taster gedrückt wird.
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